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1  Scope

This user’s manual documents the capabilities and functions of the
Enhanced Logistics Intratheater Support Tool (ELIST) software
application. Steps for using the Expanded Time Phase Force Deployment
Data (ETPFDD) Editor (ETEdit), which is included in ELIST but is also a
stand-alone software application, are contained in a separate document.

1.1 Identification

The subject of this document is ELIST Version 8.0.4 User’s Manual.
ELIST operates on either Windows NT 4.0 (or higher) or Sun/Solaris 2.6
(or higher). ELIST can also be run on Windows ’98 as a database client
if access to the Oracle database management system (DBMS) is available.

1.2 System Overviews

1.2.1 ELIST

ELIST is a discrete event simulation tool developed for use by military
planners in both the continental United States (CONUS) and outside the
continental United States (OCONUS). It simulates the reception, staging,
onward movement, and integration (RSOI) of military personnel and
equipment from all services within, between, or among countries.

ELIST not only runs a simulation, but it also provides the capability to
edit asset sets, networks, and scenarios. These capabilities show how
various changes can affect the outcome of a simulation. Further, ELIST
incorporates topographic maps on which the network is displayed. The
system also allows planners to simulate scenarios at the vehicle level.

Prior to the implementation of ELIST, planners were able to simulate
military deployment from the point of departure (origin) to the point of
arrival in the theater (the port of debarkation). Since the development and
implementation of ELIST, however, planners can simulate military
deployment from the point of departure (airport or seaport), through the
staging area, through the theater-staging base, to the final destination.

A typical scenario might be set up to transport personnel and cargo to a
location by aircraft or ship. Upon arrival at the airport or seaport, the cargo
would be sent to a staging area where it would be set up and transferred to
a vehicle, or in the case of petroleum, oil, and lubricants (POL), a pipeline.
The vehicle then would transport the cargo to the theater-staging base
where it would “marry up” with the main body of personnel. From this
point, the cargo and the main body would be transported to the final
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destination. Figure 1.1 provides an overview of ELIST’s military
deployment capability.

ELIST answers questions such as the following:

• Will the theater infrastructure support the plan?

• Are the theater assets sufficient to support the given delivery dates?

• Where are the bottlenecks in the theater transportation system?

• What are the effects of exogenous events on the transportation
infrastructure? For example, if bridges on a route are not available,
how will the flow of transportation be affected?

Figure 1.1  Military Deployment Overview
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Five items are required for an analysis:

• Reference vehicle characteristics

• Rules
– characteristics of what needs to be moved (these can be tailored

based on the features of the area, e.g., mountains)
– rules for how to move assets and in what order (priority)

• Movement requirements (ETPFDD)
– where and when
– who and what

• Infrastructure capabilities (Network)
– seaports
– airports
– roads, rails, waterways, and pipelines

• Assets available for movement (Scenario)
– host nation assets in the theater (for example, in Operation

Desert Storm, POL was not an issue because the host nation
could move that asset easily).

– arriving military assets

The ELIST system requires the use of the Oracle database management
system (DBMS) on either the Sun or the NT Windows platform.

1.2.2 ETEdit

For convenience, a brief overview of the ETEdit system is included
here. To assist ELIST users, ETEdit has been incorporated into the ELIST
program to allow easy access to data required for running simulations.

The primary purpose of ETEdit is to make changes to (edit) ETPFDDs.
For example, ETEdit provides force module data that make it possible to
view and modify movement requirements, as well as to display the cargo
detail and parent hierarchies requirement line numbers (RLNs). The types
of transport data available for editing in ETEdit are listed below:

• TUCHA sets,

• Trucks and trailers,
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• Railcars and aircraft,

• Commodity sets,

• Tractor trailers and ships, and

• Joint Operation Planning and Execution System (JOPES) codes
and ETPFDDs.

Features added to ETEdit Version 8.1 allow for planning of scenarios
at a Level 6 detail (i.e., with individual items identified with a unique
identification number [ID]) according to the unit hierarchy. It specifies the
RSOI, which provides an opportunity to use multiple intermediate
locations (ILOCs) and follow-on locations. A unit viewer is also available
for displaying — on a map — the position of each unit either on a
specified day or in a multiple-day sequence.

Like ELIST, ETEdit requires the Oracle DBMS for use with either the
Sun or the NT Windows platform.

See the ETEdit v.8.1:  User’s Manual for information concerning using
the program.

1.3 Conventions

Because it is a Windows-based application, ELIST it incorporates
many of the conventions normally found in such an application. This
section provides some basic information about how these conventions are
used in ELIST. A brief discussion of menu commands and a listing of
available buttons/icons are provided.
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1.3.1 Menu Commands

Table 1.1 provides a list of menu commands available in many ELIST
windows.

Table 1.1  Menu Commands Available in Many ELIST Windows

Command Description

Save Save changes made to a file.

Save As Saves the changes made using a new name.

Cancel
Changes

Cancel changes made to a file.

Import Import a data set.

Export Export a data set.

Reports List various types of reports that can be generated.

Close Exit the window.
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2  Referenced Documents

Computer Dictionary: The Comprehensive Standard for Business, School,
Library, and Home, Microsoft Press, Redmond, WA, 1991.

ETEdit v.8.1:  User’s Guide, prepared by Argonne National Laboratory,
Argonne, IL, for DII/COE (in progress).



ANL/DIS/TM-62 ELIST v.8.1:  User’s Manual

February 2002 2-2



February 2002 3-1

3  Software Summary

3.1 Software Description

ELIST was developed to help military planners use resources
efficiently in different types of operations under various conditions. The
system makes it possible to simulate a scenario that involves movement of
equipment via land, sea, or air or by a combination of the three types of
transport.

ELIST answers questions such as the following:

• Will the theater infrastructure support the plan?

• Are the theater assets sufficient to support the given delivery dates
(that is, are there enough railcars, aircraft, etc., to deliver the assets
on time)?

• Where are the bottlenecks in the theater transportation system?

• What are the effects of exogenous events on the transportation
infrastructure? For example, if all bridges are impassable, how will
the flow of assets be affected and how can the military react?
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Table 3.1  Capabilities, Operating Improvements, and
Benefits Provided by ELIST

Capabilities

Dynamic map interface

Create, edit, import, and export commodity and rule sets 
(ETEdit)

Edit, expand, and create TPFDD data (ETEdit)

Networks

Scenarios

Simulations

View planned movements and reports (to be added in a 
future release)

Operating Improvements
Simulation to the vehicle level

Cross-platform environment

Oracle DBMS

Benefits

Predict the feasibility of transporting sufficient supplies to a 
specified location in a given amount of time

Based on delivery time, ELIST automatically finds the shortest 
route. A future release will allow users to define routes.

Note:  ETEdit capabilities are indicated by parentheses.

For quick reference, the capabilities, operating improvements, and
benefits provided by ELIST are listed in Table 3.1. Capabilities specific to
ETEdit are also identified.

3.2 Software Inventory

The information required for identifying the software inventory will be
provided in a future version of this manual.

3.3 Hardware/Software Environment

3.3.1 Hardware Requirements

ELIST runs on either a personal computer (PC) or a Sun workstation.
The hardware requirements for each platform are listed below.
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To run ELIST on a PC:

• Minimum requirement of a Pentium processor (e.g., 500 MHz)
running Windows NT 4.0 or higher.

• A minimum of 512 MB of RAM; however, 1 GB or more of RAM
is recommended.

• 2 GB of disk space.

• A color monitor with a resolution of 1,024 × 768.

To run ELIST on a Sun workstation:

• A workstation capable of running a minimum of a Solaris 2.6 or
higher operating system.

• A minimum of 512 MB of RAM.

• 2 GB of disk space.

In addition, running ELIST requires access to the Oracle DBMS;
however, Oracle does not need to be installed on the platform. Because
Oracle has its own disk requirements, check the Oracle user’s manual for
requirements specific to that system.

Note:  Recommendations provided for the Oracle system suggest
having a PC with a minimum of two disk drives. All of the data
can be placed on one drive, while the other drive can be used for
saving the indexes about those data. Although two disk drives are
not required to run ELIST, having them will enhance the speed of
operation.

3.3.2 Data Requirements

The analysis of large TPFDDs requires a minimum of 10 GB of disk
space. A workstation that has less disk space available, for example, 1 GB,
could be used for demonstration purposes; however, it will not be possible
to analyze large TPFDDs or to store multiple scenarios, nor will it be
possible to store large scenarios or simulations.

ELIST includes the World Vector Shoreline (WVS) data set and the
Compressed ARC Digitized Raster Graphics (CADRG) data set. The total
WVS data set requires 620 MB of disk space for six resolutions of data. In
addition, each CADRG data set requires about 600 to 650 MB of disk
space.
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Table 3.2  Summary of Hardware/Software Requirements
for ELIST and ETEdit

      Item                                                         Requirement                      

Personal computer Pentium or higher (e.g., 500 MHz)
running Windows NT 4.0 or higher

Minimum of 512 MB of RAM; 1 GB
of RAM recommended

�� GB of disk space

Sun Sparc Solaris 2.6 or high operating system

Minimum of 512 MB of RAM; 1 GB
of RAM recommended

2 GB of disk space

Database management Oracle (two disk drives
recommended)

TPFDDs Minimum of 10 GB of disk space

WVS data set 620 MB of disk space

Each CADRG 600 to 650 MB of disk space
data set

3.3.3 Software Requirements

ELIST requires access to the Oracle DBMS. The Java Runtime
Environment (JRE) is also required.

3.3.4 Summary Table of Requirements

3.4  Software Organization and Operation Overview

ELIST is an important tool for military planners. With ELIST, planners
can edit asset sets, networks, and scenarios, as well as simulate the
movement of supplies. In addition, ELIST includes a capability that allows
planners to specify the amount of equipment to be moved, the type of
transport to be used, and the time of departure and arrival of equipment at
a designated location.

Several menu options are available through ELIST, and a separate
menu is provided for each major category. (See the ELIST hierarchy in
Chapter 5, Figure 5.2.) Because only one area can be edited at a time,
ELIST has built-in system checks that support data integrity.
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Loading a network or scenario may take a few minutes. Performing a
simulation, however, requires significant central processor unit (CPU)
time. The accuracy of the results of the simulation will be discussed in a
future version of this manual.

Other information regarding characteristics, functions, and reliability
will be presented in a future version of this manual.

The reports and unit viewer speed are directly linked to the speed of
the computer and the size of the TPFDD; generally, however, reports
should load in less than 30 seconds. If a power failure occurs while data
are being saved, it might be necessary to re-enter some changes; however,
all of the data will not be lost.

3.5 Modes of Operation

ELIST does not employ different modes of operation.

3.6 Security and Privacy

Warning! “Access to classified matter shall be limited to persons
who possess appropriate access authorization and who require such
access (need-to-know) in the performance of official duties” (from
Classified Matter Protection and Control Manual, DOE M 471.2-
1B, U.S. Department of Energy). When running ELIST in
classified mode, you must follow the proper procedures for
working in a classified facility. Safeguards include, for example,
not divulging your password to anyone and not making copies of
the software or printed documents.

ELIST incorporates a two-level protection system. The first level
requires a user name and a password to access the personal computer. The
use of Oracle provides a second level of protection against unauthorized
access. The system administrator can edit user names and passwords, as
required.

ELIST can be used either in a classified mode or an unclassified mode.
Classified data are accessible only by persons who have the appropriate
clearance and a need to know, that is, a need to run ELIST.

Persons who need to run ELIST in the classified mode are responsible
for following all of the procedures required for ensuring security.
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4  Access to the Software

This section provides step-by step procedures for the first-time or
occasional user who needs to access the software on a personal computer.

4.1 Software Setup

To install the ELIST software, refer to the installation instructions for
your environment, which are provided in separate documentation and
available from your system administrator.

4.1.1 Familiarization

Procedures for adjusting equipment, the characteristics of the display
screens, keyboard layout, and other information will be included in a
future version of this manual.

4.1.2 Access Control

4.1.2.1 Obtaining a User Name and Password

Users must have access to both the ELIST software and the database to
run ELIST. The system administrator (or the person responsible for this
function) can provide you with a system account and a password. During
the installation and administration of ELIST, Oracle accounts must be
provided for each user. Contact the system administrator for an Oracle
account and password.

4.1.2.2 Security and Privacy Issues for Storing Media

If you choose to save or print media, you must label each with a
descriptive name so that the file is easily identifiable. Any saved or printed
media must be maintained in a secure environment, at least to the level of
classification that ELIST runs.
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4.1.2.3 Load Projection Warning

To prevent a sharing violation, ELIST has a feature that tells you when
another person is using a file that you are trying to load. ELIST looks in
the header table and checks the Current User column for the object that
you are trying to load. If the object is in use, the Load Projection Warning
window opens (Figure 4.1).

Figure 4.1  Load Projection Warning Window

If you receive this warning when trying to load a file, check with the
other user. ELIST issues this warning to ensure that data are not edited
twice.

4.2 Starting ELIST

To start ELIST in Windows NT, double-click the ELIST shortcut icon
on your desktop or access the program through the Start menu. The initial
screen, the MS-DOS window (see Figure 4.2), displays the various files
being loaded and tracks changes made to the files. This window remains
open in the background as you work in ELIST. Programmers use the
MS-DOS window to see what is occurring while the software is running.
Most users will not need to access this information.

To start ELIST in Solaris, type the following in a terminal:
cd/apps/elist/elist8.1 (or appropriate version number). Then type the
following:  runELIST.

Note:  If your operating environment is not Windows NT or Solaris,
refer to the relevant information included in other documentation, which
is available from your system administrator.
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Warning!  Do not close the MS-DOS window. Doing so automatically
closes ELIST. If you click the x in the upper right corner, a dialog box
informs you that the application cannot respond to the End Task request.
You can then select Cancel to continue working in ELIST.

Figure 4.2  ELIST MS-DOS Window
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Within a short time, the ELIST (logo) window (Figure 4.3) opens. The
ELIST (logo) window is visible momentarily as ELIST continues to load.

Figure 4.3  ELIST (Logo) Window



ANL/DIS/TM-62 ELIST v.8.1:  User’s Manual

February 2002 4-5

Once all of the data sets required for the program have been loaded,
the ELIST:  Main window (Figure 4.4) replaces the ELIST (logo) window.
All of the tasks required to run a simulation can be accessed from this
window.

Figure 4.4  ELIST Main Window

Note:  The time required to open the ELIST:  Main window varies
according to the PC or workstation used. The primary indication that
data continue to be loaded is the hourglass symbol in the ELIST (logo)
window. Also, the MS-DOS window behind the ELIST (logo) window
displays the programming codes being generated as ELIST is loaded and
used.

Instructions for running ELIST on the Sun platform will be included in
a future version of this manual.

A problem determination checklist will also be included in the final
version of this manual.
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4.3 Stopping and Suspending Work

You must click File>Save to retain any changes made to your work
and then File>Exit as described in Chapter 5. The capability to suspend
work has not been implemented and will be included in a future release of
the software.
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5  Using ELIST

This chapter describes how to use the menu commands and tabs in
ELIST. Detailed descriptions of the ELIST windows are provided in
Chapter 6.

The ELIST window is the entry point for using all ELIST function-
alities (Figure 5.1). The menus and buttons on this window allow you to
perform tasks from planning and developing a scenario to running
simulations. Figure 5.2 provides an overview of the various functionalities
provided by ELIST.

Figure 5.1  ELIST Window
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Most of the windows in ELIST contain a File menu item (Figure 5.3).
The File menu contains a list of commands that allows you to save
information that was recently entered (Save) or to save an item using a
different name (Save As). You can also cancel any changes made to the
file (Cancel Changes), delete items (Delete), or close the window (Exit).
The Exit command closes the window and exits ELIST.

Figure 5.3  File Menu Item—ELIST Vehicles Window

Many of the windows also contain the  (Show Update Log) and 
(Show Status) icons near the upper right corner of the window. The
Show Update Log tracks the changes made in a window and allows you
to selectively undo changes. The  (Show Status) icon, which is
displayed in many windows, allows you to view errors and warnings
associated with the data.

All edits are stored only in memory (RAM) and are not saved
permanently to the database (hard disk) until you select the File>Save
command. Items that have been changed but not saved to the database
can be undone, as described in the next section. Figure 5.4 on the
following page illustrates how information is stored in ELIST.

The File menu
list is displayed
on most of the
ELIST windows.

Show
Update
Log

Add/Delete Buttons
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To Undo Changes

1. Click the Show Update Log icon. The Change Log: ETEdit: Rules
window opens (or another window opens if this icon is an option)
that displays a list of items that have been changed (see sample in
Figure 5.5). The items are listed in the following order:  the item
most recently changed is displayed at the top of the list, and the
item changed first (i.e., the oldest change) is displayed at the
bottom of the list.

Figure 5.5  Change Log: ETEdit: Rules Window

Figure 5.4  Edits in ELIST Are Stored in Memory
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2. To undo changes made to an item, click the item name. The
selected item and everything above it are then highlighted.

3. Click the Undo button. All the actions performed on the
highlighted items are undone, and the items are removed from the
window. The data on the ETEdit window are returned to their
original values.

4. When you have finished viewing/editing the change log, click the
Done button. The Change Log window closes.

5. To save all changes permanently to the database, click Save on
the File menu.

To Display Data Inconsistencies

1. Click the Show Status icon. The ILLEGAL_MODEL window
opens, displaying a list of data inconsistencies (Figure 5.6).

Figure 5.6  Status Window: ILLEGAL_MODEL

2. Use the list of data inconsistencies to enter data that are consistent
with the items shown.

3. Continue with Step 2 until all inconsistencies have been
eliminated from the list.

4. When you have fixed all of the inconsistencies, the READY
window opens (Figure 5.7). This window shows that you have
corrected all inconsistencies and can proceed.

Figure 5.7  READY Window
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5.1 File Commands

Three File commands are available on the ELIST window:  SQL,
Trace, and Exit. Windows are described in detail in Chapter 6. Table 5.1
gives brief descriptions of the File commands.

Table 5.1  File Commands

Command Description

SQL Track queries and updates to the database.

Trace Track additional outputs for various aspects of the system.

Exit Exit ELIST.

To Exit ELIST

1. On the File menu, click Exit. The Confirm exit window opens.

2. Perform one of the following:

•  To exit ELIST, click Yes. The Confirm exit window closes
along with the ELIST and MS-DOS windows.

•  To cancel the Exit command and continue working, click No.
The Confirm exit window closes.



ANL/DIS/TM-62 ELIST v.8.1: User’s Manual

March 2002 5-7

5.2 View Commands

Ten View commands are available on the ELIST window:  Map, Logo,
Thumbnail, Map Properties, Zoom, Pre-saved Maps, View TACWAR
Units, View Force Modules, Export Map, and Print Map. Windows are
described in detail in Chapter 6. Table 5.2 gives brief descriptions of the
View commands. The Glossary contains a list of terms and icons/buttons
that are associated with some of the commands. Commands that have
icons available are noted in parentheses after the brief description.

Table 5.2  View Commands

Command Descriptiona

Map Shows the map as the background display. Alternatively, it could be
the logo.

Logo Displays the ELIST logo in the ELIST window for display only.
Alternatively, it could be a map background.

Thumbnail Displays a small view of the map that allows users to graphically pan
to any location on the globe. (See Glossary.)

Map Properties Allows you to control the way in which the map is displayed.

Zoom Modifies the way in which the map is displayed. (See Glossary.)

Pre-saved Maps Allows storage and saving of the information needed to quickly return
to a given map display.

View TACWAR
Units

Displays overlays on the map that result from a given TACWAR
scenario. (In a future release of ELIST, it will be possible to edit and
view these units.)

View Force
Modules

Allows viewing, over time, of the movement of the TPFDD. (See
Glossary.)

Export Map Saves the map to a *.gif file.

Print Map Prints the map or area of the map that you are viewing.

a   Items that are accessible through an icon are identified in the Glossary.

The view commands will be documented in a later version of this manual.
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5.3 Reference Commands

Five Reference commands are available on the ELIST window:
TUCHA, GEOLOC FILES, Vehicles, Asset Matching, and Enabler
Matching. Windows are described in detail in Chapter 6. Table 5.3 gives
brief descriptions of the Reference commands. Procedures for using
these commands are provided on the following pages.

Table 5.3  Reference Commands

Command Description

TUCHA A Type Unit Characteristics (TUCHA) file (see Section 5.3.1).

View TUCHA Displays a TUCHA file (see Section 5.3.1.1).

Import TUCHA
Flat File

Allows you to import a TUCHA flat file (see Section 5.3.1.2).

Import TUCHA
(ELIST Format)

Allows you to import a TUCHA file in ELIST format (see
Section 5.3.1.3).

Export TUCHA
(ELIST Format)

Allows your to export a TUCHA file in ELIST format (see
Section 5.3.1.4).

Delete TUCHA Allows you to delete a TUCHA file from the database (see
Section 5.3.1.5).

GEOLOC FILE Allows you to import, export, or deletion of a GEOLOC file. The
file can be a flat file, or it can be in ELIST format (see
Section 5.3.2).

Edit GEOFILE Allows you to edit a GEOFILE (see Section 5.3.2.1).

Import GEOFILE
Flat File

Allows you to import a GEOLOC flat file (see Section 5.3.2.2).

Import GEOFILE
(ELIST Format)

Allows you to import a GEOLOC file in ELIST format (see
Section 5.3.2.3).

Export GEOFILE
(ELIST Format)

Allows you to export a GEOLOC file in ELIST format (see
Section 5.3.2.4).

Delete GEOFILE Allows you to deletes a GEOFILE from the database (see
Section 5.3.2.5).

Vehicles Defines the characteristics of each vehicle used to transport cargo
or personnel (see Section 5.3.3).

Asset Matching Provides a table for locating military assets that arrive in the
theater. These assets become additional resources for movement
(see Section 5.3.4).

Enabler Matching Allows the identification of the types of units (i.e., personnel and
equipment) that can increase the capability of a location (see
Section 5.3.5).
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5.3.1  Reference>TUCHA Commands

Five TUCHA commands are available: View TUCHA, Import TUCHA
flat file, Import TUCHA (ELIST format), Export TUCHA (ELIST format),
and Delete TUCHA. Table 5.4 gives brief descriptions of the TUCHA
commands. Procedures for using these commands are provided on the
following pages.

5.3.1.1  TUCHA>View TUCHA Command

Use the following procedures to view (display) a TUCHA file.

1. As needed, load an ETPFDD. (Refer to Procedure 5.6.2.) The
ETEdit (main) window opens.

2. As needed, display the RLNs on the ETEdit (main) window. (In
the ETEdit User’s Manual, Chapter 5, refer to the procedures
titled View>Select RLN’s and View>Select Force Modules.)

3. Close the ETEdit (main) window.

Table 5.4  Reference>TUCHA Commands

Command Description

View TUCHA Allows you to view (display) a TUCHA file (see Section 5.3.1.1).

Import TUCHA
flat file

Imports a TUCHA flat file (see Section 5.3.1.2).

Import TUCHA
(ELIST format)

Imports a TUCHA file in ELIST format (see Section 5.3.1.3).

Export TUCHA
(ELIST format)

Exports a TUCHA file in ELIST format (see Section 5.3.1.4).

Delete TUCHA Allows you to delete a TUCHA file (see Section 5.3.1.5).
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4. On the ELIST window, on the Reference menu, click
TUCHA>View TUCHA. The ELIST: View TUCHA window opens
(Figure 5.8).

Figure 5.8  ELIST: View TUCHA Window

5. Click  (the Select TUCHA’s icon). The Select TUCHA window
opens (Figure 5.9).

Figure 5.9  Select TUCHA Window

6. Click either or both of the check boxes below the word Enable at
the top of the window. This action enables the corresponding line
on which search parameters are entered.

7. As needed, enter the Arguments, Operator, and Value in the
corresponding text box (e.g., UTC = U5BNN or UTCname
contains Truck).
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8. Perform one of the following:

•  To display the TUCHA files, click OK. The Select TUCHA
window closes, and the ELIST: View TUCHA window displays
the TUCHA file populated with the items selected on the
Select TUCHA window (Figure 5.10).

Figure 5.10  ELIST: View TUCHA Window

•  To cancel this operation, click Cancel. The Select TUCHA
window closes.

5.3.1.2 TUCHA>Import TUCHA Flat File Command

This procedure will be documented in a future version of this manual.

5.3.1.3  TUCHA>Import TUCHA (ELIST Format) Command

This procedure will be documented in a future version of this manual.

5.3.1.4  TUCHA>Export TUCHA (ELIST Format) Command

This procedure will be documented in a future version of this manual.

5.3.1.5  TUCHA>Delete TUCHA Command

Use the following procedures to delete a TUCHA.

1. As needed, load an ETPFDD. (Refer to Procedure 5.6.2.) The
ETEdit (main) window opens.

2. As needed, display the RLNs on the ETEdit (main) window. (In
the ETEdit User’s Manual, in Chapter 5, refer to the procedures
titled View>Select RLN’s and View>Select Force Modules.)
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3. Close the ETEdit (main) window.

4. On the ELIST window, on the Reference menu, click
TUCHA>Delete TUCHA. The Delete Tucha window opens
(Figure 5.11).

Figure 5.11  Delete TUCHA Window

5. In the TUCHA Sets panel, click the TUCHA file to delete. The
selected line is highlighted.

6. Perform one of the following:

•  To delete the selected TUCHA file, click OK. The Delete
TUCHA window closes, and the TUCHA file is deleted.

•  To cancel this operation, click Cancel. The Delete TUCHA
window closes, and the file is not deleted.
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5.3.2 Reference>GEOLOC FILE Commands

Five GEOLOC FILE (Geographic Location file) commands are
available on the ELIST (map) window:  Edit GEOFILE, Import GEOFILE
flat file, Import GEOFILE (ELIST format), Export GEOFILE (ELIST
format), and Delete GEOFILE. Table 5.5 gives brief descriptions of the
TUCHA commands. Procedures for using these commands are provided
on the following pages.

5.3.2.1  To Edit a GEOFILE

Note:  Only user-defined GEOLOCs can be edited.

1. As needed, load an ETPFDD. (Refer to Procedure 5.6.2.) The
ETEdit (main) window opens.

2. Close the ETEdit (main) window.

Table 5.5  Reference>GEOLOC FILE Commands

Command Description

Edit GEOFILE Allows you to edit a GEOFILE, which included changing the
GEOLOC parameters, creating a GEOLOC, and deleting a
GEOLOC (see Sections 5.3.2.1 through 5.3.2.3).

Import GEOFILE
flat file

Imports a GEOFILE flat file (see Section 5.3.2.4).

Import GEOFILE
(ELIST format)

Imports a GEOFILE in ELIST format (see Section 5.3.2.5).

Export GEOFILE
(ELIST format)

Exports a GEOFILE in ELIST format (see Section 5.3.2.6).

Delete GEOFILE Allows you to delete a GEOFILE (see Section 5.3.2.7).
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3. On the Reference menu, click GEOLOC FILE>Edit GEOFILE.
The ELIST: Edit Geolocs window opens (Figure 5.12).

Figure 5.12  ELIST: Edit Geolocs Window

4. Click  (Select Geolocs icon). The Select Geolocs window
opens (Figure 5.13).

Figure 5.13  Select Geolocs Window

5. Click the check boxes below the word Enable at the top of the
window, as needed. This action enables the corresponding line on
which search parameters are entered.

6. As needed, enter the And/Or, Arguments, Operator, and Value in
the corresponding text box (e.g., LocationName contains Texas).
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7. Perform one of the following:

•  To display the GEOLOC that meet the search parameters,
click OK. The Select Geolocs window closes, and the ELIST:
Edit Geolocs window displays the selected GEOLOCs in the
GEOLOCs panel (Figure 5.14).

Figure 5.14  ELIST: Edit Geolocs Window

•  To cancel this operation, click Cancel. The Select Geolocs
window closes.

8. Click the GEOLOC to be edited. The selected line is highlighted.
Note: click a GEOLOC that has the User Defined box checked;
only user-defined GEOLOCs can be edited.

9. Click . The Add Geoloc window opens (Figure 5.15).

Figure 5.15  Add Geoloc Window

10. Edit the GEOLOC parameters, as needed. Note:  the Geoloc Code
cannot be changed; the text box is disabled.
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11.  Perform one of the following:

•  To save the GEOLOC file with the new parameters, click OK.
The Add Geoloc window closes, and the file is displayed on
the ELIST: Edit Geolocs window with the new parameters.

•  To cancel this operation, click Cancel. The Add Geoloc
window closes.

5.3.2.2  To Create (Add) a GEOLOC

1. As needed, load an ETPFDD. (Refer to Procedure 5.6.2.) The
ETEdit (main) window opens.

2. Close the ETEdit (main) window.

3. On the Reference menu, click GEOLOC FILE>Edit GEOFILE.
The ELIST:  Edit Geolocs window opens (Figure 5.16).

Figure 5.16  ELIST: Edit Geolocs Window



ANL/DIS/TM-62 ELIST v.8.1: User’s Manual

March 2002 5-18

4. Click  . The Select Geolocs window opens (Figure 5.17).

Figure 5.17  Select Geolocs Window

5. Click the check boxes below the word Enable at the top of the
window, as needed. This action enables the corresponding line on
which search parameters are entered.

6. As needed, enter the And/Or, Arguments, Operator, and Value in
the corresponding text box (e.g., LocationName contains Texas).

7. Perform one of the following:

•  To display the GEOLOC that meet the search parameters,
click OK. The Select Geolocs window closes, and the ELIST:
Edit Geoloc window displays the selected GEOLOC files in
the GEOLOCs panel (Figure 5.18).

Figure 5.18  ELIST: Edit Geolocs Window

•  To cancel this operation, click Cancel. The Select Geolocs
window closes.
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8. Click the GEOLOC to be copied. The selected line is highlighted.

9. Click  . The Add Geoloc window opens (Figure 5.19).

Figure 5.19  Add Geoloc Window

10. Type the required information into the corresponding text boxes.

11. Perform one of the following:

•  To add the new GEOLOC to the database, click OK. The Add
Geoloc window closes, and the new file is displayed on the
ELIST: Edit Geolocs window.

•  To cancel this operation, click Cancel. The Add Geoloc
window closes.

5.3.2.3  To Delete a GEOLOC

Use the following procedure to delete a GEOLOC from a given
GEOLOC data set. To delete a GEOLOC data set, refer to
Procedure 5.3.2.7 (To Delete a GEOLOC Data Set).

1. As needed, load an ETPFDD. (Refer to Procedure 5.6.2.) The
ETEdit (main) window opens.

2. Close the ETEdit (main) window.
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3. On the Reference menu, click GEOLOC FILE>Edit GEOFILE.
The ELIST: Edit Geolocs window opens (Figure 5.20).

Figure 5.20  ELIST: Edit Geolocs Window

4. Click . The Select Geolocs window opens (Figure 5.21).

Figure 5.21  Select Geolocs Window

5. Click the check boxes below the word Enable at the top of the
window, as needed. This action enables the corresponding line on
which search parameters are entered.

6. As needed, enter the And/Or, Arguments, Operator, and Value in
the corresponding text box (e.g., LocationName contains Texas).
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7. Perform one of the following:

•  To display the GEOLOCs that meet the search parameters,
click OK. The Select Geolocs window closes, and the ELIST:
Edit Geolocs window displays the selected GEOLOCs in the
GEOLOCs panel (Figure 5.22).

Figure 5.22  ELIST: Edit Geolocs Window

•  To cancel this operation, click Cancel. The Select Geolocs
window closes.

8. Click the GEOLOC to be deleted. The selected line is highlighted.
Note: click a GEOLOC that has the User Defined box checked;
only user-defined GEOLOCs can be deleted.

9. Click . The selected GEOLOC file is deleted.

5.3.2.4  To Import a GEOLOC Flat File (Set)

1. On the Reference menu, click GEOLOC FILE>Import GEOFILE
flat file. The Import Geoloc File window opens (Figure 5.23).

Figure 5.23  Import Geoloc File Window
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2. Perform one of the following:

•  To import a GEOLOC flat file, type the path and name in the
Geoloc File text box. Proceed to Step 3.

•  To search for a GEOLOC file to import, click the Browse…
button.

3. To give the imported flat file/set a new name, type the name for
the imported GEOLOC file/set in the New Geoloc Set Name text
box. Otherwise, proceed to Step 4.

4. In the GEOLOC Sets panel, click a GEOLOC set to import. The
selected line is highlighted.

5. Perform one of the following:

•  To import the GEOLOC set, click OK. The Import Geoloc File
window closes, and the GEOLOC set is imported.

• To cancel this operation, click Cancel. The Import Geoloc File
window closes, and the GEOLOC set is not imported.

5.3.2.5  To import a GEOLOC in ELIST Format

1. On the Reference menu, click GEOLOC FILE>Import GEOFILE
(ELIST format). The Import GeolocFile Export File window opens
(Figure 5.24).

Figure 5.24  Import GeolocFile Export File Window

2. Perform one of the following:

•  To import a GEOLOC file in the ELIST format, type the path
and name of the file in the GeolocFile Export File text box.
Skip to Step 6.

•  To search for a GEOLOC file, click the Browse… button.
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3. Perform one of the following:

•  To import the GEOLOC (ELIST format) file, click OK. The
Import GeolocFile Export File window closes, and the
GEOLOC (ELIST format) file is imported.

•  To cancel this operation, click Cancel. The Import GeolocFile
Export File window closes.

5.3.2.6  To Export a GEOLOC (ELIST Format)

1. On the Reference menu, click GEOLOC FILE>Export GEOFILE
(ELIST format). The Export Geoloc File window opens
(Figure 5.25).

Figure 5.25  Export Geoloc File Window

2. In the GEOLOC Sets panel, click the name of the GEOLOC data
set to be exported. The selected line is highlighted.

3. Perform one of the following:

•  To export the GEOFILE (ELIST format), click OK. The
Export Geoloc File window closes, and the GEOFILE (ELIST
format) is exported.

• To cancel this operation, click Cancel. The Export Geoloc File
window closes.
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5.3.2.7  To Delete a GEOFILE (GEOLOC Data Set)

Use the following procedure to delete a GEOLOC data set. To delete
a file from a GEOLOC data set, refer to Procedure 5.3.2.3 (To Delete a
GEOLOC File).

1. On the Reference menu, click GEOLOC FILE>Delete GEOFILE.
The Delete GeolocFile window opens (Figure 5.26).

Figure 5.26  Delete GeolocFile Window

2. In the GEOLOC Sets panel, select the GEOFILE (GEOLOC data
set) to be deleted. The selected line is highlighted.

3. Perform one of the following:

•  To delete the selected GEOFILE, click OK. The Delete
GeolocFile window closes, and the GEOFILE (GEOLOC data
set) is deleted.

• To cancel this operation, click Cancel. The Delete GeolocFile
window closes, and the GEOFILE (GEOLOC data set) is not
deleted.
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5.3.3  Reference>Vehicles Command

The Vehicles command opens the ELIST: Vehicles window, which is
used for editing vehicles. This window contains several tabs, each listing
a different class of vehicle. The procedure that follows describe use of the
Trucks tab. Except for the Tractor/Trailer Matching tab, the information
contained on the other tabs is similar to that of trucks and can be changed
in the same way. Therefore, procedures for the Tractors, Trailers,
Railcars, Fixed Wing, Rotary Wing, Ship Types, and Ships tabs are not
included in this manual.

Warning!  There is only one set of vehicle definitions.
Reference data do not depend on a folder. Changes made to
items in the Vehicles window affect all folders.

Procedures for using the Tractor/Trailer Matching tab follow the
Trucks tab procedures (see Section 5.3.3.1).

Table 5.6 gives brief descriptions of the Vehicles File commands.

Table 5.6  Reference>Vehicles File Commands

Command Description

Save Saves the changes made to a set of vehicles.

Cancel
Changes

Cancels any changes made to a set of vehicles.

Import Imports a data set in ELIST format.

Export Exports a data set in ELIST format.

Reports Lists various types of reports that can be generated for each of the
types of vehicles listed on the tabs (e.g., all, trucks, tractors, trailers,
and so on).

Close Allows you to close the Vehicles window.
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5.3.3.1  Vehicles: Trucks Tab

Use the following procedures to display vehicle (i.e., trucks, tractors,
trailers, railcars, fixed wing, rotary wing, ship types, or ships)
information, to edit vehicle information, and to add and delete vehicles.

Note 1:  Except for the Tractor/Trailer Matching tab, the
information contained on the other tabs is similar to that of
trucks and can be changed in the same way. Therefore,
procedures for the Tractors, Trailers, Railcars, Fixed Wing,
Rotary Wing, Ship Types, and Ships tabs are not included in
the following procedures.

Note 2:  Save changes after performing each procedure. When
you have finished working with Vehicles, close the window.

To Display Vehicle Information

1. On the Reference menu, click Vehicles. The ELIST: Vehicles
window opens (Figure 5.27).

Figure 5.27  ELIST: Vehicles Window

2. Click a vehicle tab (e.g., Trucks, Tractors, and Trailers) to display
a list of vehicle types and their respective attributes.
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Note:  The  (add) and  (delete) buttons work in the same
way for each tab on the ELIST: Vehicles window. Clicking

the  (Show Update Log) icon displays the changes made to
all vehicle types. Clicking the 

 
 (Show Status) icon

displays errors and warnings associated with the data.

To Edit Vehicle Information

1. As needed, display the vehicle information (see previous
procedure).

2. To edit the information (i.e., Type, LIN, Weight Capacity, POL
Capacity, and so forth), double-click the desired cell. The cell
background changes color.

3. Type the new data for the specific attribute.

Note:  Click any column heading in the table to sort the
vehicle characteristics by, for example, type or LIN.

To Add a Vehicle

1. As needed, display the vehicle information (see previous
procedure).

Note:  Click any column heading in the table to sort the
vehicle characteristics by, for example, type or LIN.

2. Click the row that contains a vehicle type similar to the vehicle
being added. The row is highlighted.

Note:  If you do not have a row selected and you click Add
Vehicle, you must type all of the values required for that
vehicle; that is, values are not automatically specified, as is
the case when you highlight the row.
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3. Click  . The Add Truck window opens (Figure 5.28).

Figure 5.28  Add Truck Window

4. Type the needed information into each text box and click the OK
button. The Add Truck window closes, and the new vehicle and its
information are added to the list in the ELIST:  Vehicles window.

To Delete a Vehicle

1. As needed, display the vehicle information (see previous
procedure).

2. Click the row that contains the vehicle to be deleted. The row is
highlighted.

3. Click . The Confirm Delete window opens.
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4. Perform one of the following:

•  To delete the selected truck type, click Yes. The Confirm
Delete window closes, and the selected vehicle type is
removed from the list in the ELIST:  Vehicles window.

•  To cancel this operation without deleting the selected vehicle
type, click No. The Confirm Delete window closes.

5.3.3.2  Vehicles: Tractor/Trailer Matching Tab

To Match Trailers to a Tractor

Note 1:  Except for the Tractor/Trailer Matching tab, the
information contained on the other tabs is similar to that of
trucks and can be changed in the same way. Therefore,
procedures for the Tractors, Trailers, Railcars, Fixed Wing,
Rotary Wing, Ship Types, and Ships tabs are not included in the
following procedure.

Note 2:  This tab identifies which type of tractor can pull which
type of trailer; that is, it matches a tractor with the correct trailer.

1. On the ELIST: Vehicles window, click the Tractor/Trailer
Matching tab. Tractors are listed in their corresponding column
(Figure 5.29).

Figure 5.29  Tractor/Trailer Matching Tab
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Note:  In the Tractor/Trailer Matching Tab window, the tab is
divided into two columns. Tractor types are listed at the left.
Trailer types, which are initially blank, are listed at the right.

2. Click the desired tractor type. The tractor type is highlighted, and
the Trailers column displays a list of trailers that are available for
the selected tractor type (Figure 5.30).

Figure 5.30  Tractor/Trailer Matching Tab

3. Click the trailer type(s) for the selected tractor. The selected
trailer types are highlighted.

Note:  The trailers listed for each tractor vary on the basis of
tractor type (e.g., whether the tractor is exclusively for
military or for commercial use). Select as many trailer types
as required.

4. Repeat Steps 2 and 3, as needed, until all the trailers have been
matched with the tractors that can pull them.
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5.3.3.3  To Import an ELIST Format File

The Import (ELIST Format) command allows you to import a
vehicle dataset from a file that has previously been exported from
ELIST 8.

To Import a Vehicles Dataset

1. As needed, display units and vehicle types (see Procedure
5.3.3.1).

2. On the File menu, click Import (ELIST format). The Import
Vehicles Export File window opens (Figure 5.31).

Figure 5.31 Import Vehicles Export File Window

Note:  If you know the path and name of the file to be
imported, type it in the Vehicles Export File text box and
click OK. Otherwise, use the following procedure.

3. Click the Browse button. The Vehicles Export File window opens
(Figure 5.32).

 
 Figure 5.32  Vehicles Export File Window

Note:  To import a file, first locate an export file. Use the
Vehicle Export File window to do so.
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4.  Perform one of the following:

•  To import a file, click the filename in the Vehicles Export File
window. The selected filename is highlighted. Then click OK.
The Vehicles Export File window closes, and the filename is
automatically displayed in the Import Vehicles Export File
window text box.

•  To cancel this operation, click Cancel. The Vehicles Export
File window closes.

5. Perform one of the following on the Import Vehicles Export File
window.

•  To import the ELIST format file, click OK. The file is
imported, and the Import Vehicles Export File window closes.

•  To cancel this operation, click Cancel. The Import Vehicles
Export File window closes.

5.3.3.4  To Export an ELIST Format File

The Export (ELIST Format) command allows you to import a
vehicle dataset in the ELIST 8 format.

To Import a Vehicles Dataset

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).

2. On the File menu, click Export (ELIST format). The Export File
window opens (Figure 5.33).

Figure 5.33 Export File Window

3. Type the path and name of the file in the File Name text box.

4. Perform one of the following:

•  To export the file, click OK. If the filename is acceptable, the
file is saved in the DATA_DIR directory, and the Export File
window closes.
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Note:  If a filename was not entered in the Export File
window or if an incorrect filename was entered in Step 3,
a warning is displayed, advising you that a filename was
not entered.

•  To cancel this operation, click Cancel. The Export File
window closes.
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5.3.4  Reference>Asset Matching Command

Use the following procedures to correlate units or types (by UTC) in
the TUCHA with numbers of vehicles in them, thereby making them
available for use within ELIST simulations. You can display asset
matches, view and modify vehicle assignments, and add asset matches to
and delete asset matches from the database. In addition you can import
and export datasets.

Note:  Save changes after completing each of the following
procedures. When finished with asset matching, close the
window.

Table 5.7 gives brief descriptions of the Asset Matching commands.

Table 5.7  Reference>Asset Matching File Commands

Command Description

Save Saves the changes made to the vehicles and the assets with which
they have been matched.

Cancel
Changes

Cancels any changes made to the Asset Matching window.

Import Imports a data set in ELIST format (see Section 5.3.4.7).

Export Exports a data set in ELIST format (see Section 5.3.4.8).

Close Allows you to close the Asset Matching window.
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5.3.4.1  To Display Unit and Vehicle Types

1. On the Reference menu, click Asset Matching. The ELIST: Asset
Matching window opens (Figure 5.34).

Figure 5.34  Asset Matching Window

Note:  Click UTC to sort these items and list them in
ascending alphanumeric order. Click Name to sort these
items and list them in ascending alphabetical order.
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2. To display the number of vehicle types available for a unit type,
click either the UTC number or the name of the asset matching
selection. The selected row is highlighted, and the vehicle types
for the selected asset match are displayed at the bottom of the
window (Figure 5.35).

Figure 5.35  Asset Matching Window

5.3.4.2  To Edit Arriving Asset Matching and Vehicle Types

Note:  The information in the UTC column in the top panel
and the Vehicle Type column in the bottom panel cannot be
edited.

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).

2. Double-click the item to be edited (i.e., Name, ST, Total Number,
or # Available For Theater). The selected item is no longer
highlighted.

3. Type the new name, weight, total number, or number available for
the theater into the corresponding cell.

Note:  The  (Show Update Log) icon is available on this
window. Refer to page 5-3 for information about the Show
Update Log icon.
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4. Repeat Steps 2 and 3 until the desired items have been edited.

5.3.4.3  To Add an Asset Match to the Database

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).

2. Click  in the UTC table in the top panel. The Add Asset Match
window opens (Figure 5.36).

Figure 5.36  Add Asset Match Window

1. Type the UTC, name, and weight of the new arriving asset into
the corresponding text boxes.

2. Perform one of the following:

•  To add the new asset to the database, click OK. The Add
Arriving Asset window closes, and the new asset is added to
the list of arriving assets.

• To cancel this operation, click Cancel. The Add Arriving Asset
window closes, and the new asset is not added to database.

5.3.4.4  To Delete an Asset Match from the Database

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).

2. Click either the UTC number or the name of the asset. The
selected row is highlighted.

3. Click  at the bottom of the Vehicle Type table in the bottom
panel. The asset is deleted from the list of arriving assets.
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5.3.4.5  To Add a Vehicle Type to a Selected Unit Type

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).

2. Click either the UTC number or the name of the asset to which
you want to add a vehicle type. The selected row and the
corresponding vehicle type(s) available for this asset are displayed
in the bottom panel.

3. Click  in the Vehicle Type table in the bottom panel. The Add
Asset Match Vehicle window opens (Figure 5.37).

Figure 5.37  Add Asset Match Vehicle Window

4. Click the Filter (if desired) �����������	
��������
��	����
displays a list of specific vehicle types (e.g., trucks, railcars,
aircraft, all).

5. From the drop-down list, select the same vehicle type that you
want to add. The drop-down list closes, and the selected vehicle
type is displayed in the text box.

6. As needed, scroll the list of vehicle types and click the desired
type. The selected item is highlighted.

Note: To select several vehicles at one time, press and hold
the Ctrl key and click the names of various vehicles.
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7. Click the Total Number of Vehicles text box, and type the number
of vehicles that are available.

8. Click in the Number Available for Theater text box, and type the
number of vehicles that are available for this theater.

9. Perform one of the following:

• To add this vehicle type to the selected arriving asset, click
OK. The Add Arriving Asset Vehicle window closes, and the
selected type is added to the list of vehicle types in the bottom
panel.

• To cancel this operation, click Cancel. The Add Arriving Asset
Vehicle window closes.

5.3.4.6  To Delete a Vehicle Type from the Selected Unit Type

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).

2. Click either the UTC number or the name of the asset from which
you want to delete a vehicle type. The selected row is highlighted,
and the corresponding vehicle type(s) are displayed in the bottom
panel.

3. In the bottom panel, click the vehicle type to be deleted. The
selected vehicle type is highlighted.

4. Click   in the Vehicle Type table in the bottom panel. The
selected vehicle type is deleted from the database.

5.3.4.7  To Import an ELIST Format File

The Import (ELIST Format) command allows you to import a
dataset from a file that has previously been exported from ELIST 8.

To Import a Dataset

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).
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2. On the File menu, click Import (ELIST format). The Import
AssetMatch Export File window opens (Figure 5.38).

Figure 5.38 Import AssetMatch Export File Window

Note: If you know the path and name of the file to be
imported, type it in the AssetMatch Export File text box and
click OK. Otherwise, use the following procedure.

3. Click the Browse button. The AssetMatch Export File window
opens (Figure 5.39).

 
 Figure 5.39  AssetMatch Export File Window

Note: To import a file, first locate an export file. Use the
AssetMatch Export File window to do so.

4.  Perform one of the following:

•  To import a file, click the filename in the AssetMatch Export
File window. The selected filename is highlighted. Then click
OK. The AssetMatch Export File window closes, and the
filename is automatically displayed in the Import AssetMatch
Export File window text box.
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•  To cancel this operation, click Cancel. The AssetMatch Export
File window closes.

5. Perform one of the following on the Import AssetMatch Export
File window.

•  To import the ELIST format file, click OK. The file is
imported, and the Import AssetMatch Export File window
closes.

•  To cancel this operation, click Cancel. The Import
AssetMatch Export File window closes.

5.3.4.8  To Export an ELIST Format File

The Export (ELIST Format) command allows you to import an
exported dataset in the ELIST 8 format.

To Export a Dataset

1. As needed, display units and vehicle types (see Procedure
5.3.4.1).

2. On the File menu, click Export (ELIST format). The Export File
window opens (Figure 5.40).

Figure 5.40  Export File Window

3. Type the path and name of the file in the File Name text box.

4. Perform one of the following:

•  To export the file, click OK. If the filename is acceptable, the
file is saved in the C:\ELIST\ELIST8_data directory, and the
Export File window closes.

Note: If a filename was not entered in the Export File
window or if an incorrect filename was entered in Step 3,
a warning is displayed, advising you that a filename was
not entered.
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•  To cancel this operation, click Cancel. The Export File
window closes.
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5.3.5  Reference>Enabler Matching Command

Use the following procedures to identify the types of units
(i.e., personnel and equipment) that can increase the capability of a
location. In addition, UTCs can be added to or deleted from the list, and
the capabilities of each enabler attribute can be changed.

5.3.5.1  To Display Enabler Attributes

1. On the Reference menu, click Enabler Matching. The ELIST:
Enabler Matching window opens (Figure 5.41).

Figure 5.41  ELIST: Enabler Matching Window

Note: In the upper half of the Enabler Matching window,
click the corresponding column name (i.e., UTC, Name, or
ST) to sort these items and display them in ascending
alphanumeric order.
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2. To display enabler attributes and the corresponding capabilities
for a specific unit type, click either the UTC number or the name
of the unit. The selected row is highlighted, and the enabler
attributes and additional capabilities for the selected unit are
displayed at the bottom of the window (Figure 5.42).

Figure 5.42  ELIST: Enabler Matching Window

3. As needed, expand and collapse the enabler attributes to display
the desired item(s) and corresponding additional capability.

5.3.5.2  To Edit the “Additional Capability” Values

Note:  The information in the UTC, Name, and ST columns in
the top panel cannot be edited.

1. As needed, display the enabler attributes (see Procedure 5.3.5.1).

2. In the lower panel, locate the required item, and type the value of
the additional capability in the corresponding text box.
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3. Perform one of the following:

•  To save the change(s), on the File menu, click Save.

•  To cancel the change(s), on the File menu, click Cancel
Changes.

Note:  The  (Change Log) icon is available on this
window. Refer to page 5-3 for information about this
icon.

5.3.5.3  To Add a Unit to the Database

1. As needed, display the enabler attributes (see Procedure 5.3.5.1).

2. Click  in the top panel. The Add Arriving Enabler window opens
(Figure 5.43).

Figure 5.43  Add Arriving Enabler Window

3. Type the UTC, name, and weight of the new arriving enabler into
the corresponding text boxes.

4. Perform one of the following:

•  To add the new enabler to the database, click OK. The Add
Arriving Enabler window closes, and the new enabler is
added to the list of enablers in the top panel of the ELIST:
Enabler Matching window.

• To cancel this operation, click Cancel. The Add Arriving
Enabler window closes, and the new enabler is not added to
database.
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5. Enter (edit) the “additional capability” for the new enabler(s) (see
Procedure 5.3.5.2).

5.3.5.4  To Delete a Unit from the Database

1. As needed, display the enabler attributes (see Procedure 5.3.5.1).

2. Click either the UTC number or the name of the enabler. The
selected row is highlighted.

3. Click  in the top panel. The enabler is deleted from the list.

5.3.5.5  To Import an ELIST Format File

The Import (ELIST Format) command allows you to import an enabler
match file from a file that has previously been exported from ELIST 8.

To Import an Enabler Match File

1. As needed, display the enabler attributes (see Procedure 5.3.5.1).

2. On the File menu, click Import (ELIST Format). The Import
EnablerMatch Export File window opens (Figure 5.44).

Figure 5.44  Import EnablerMatch Export File Window

Note: If you know the path and name of the file to be
imported, type it in the EnablerMatch Export File text box
and click OK. Otherwise, use the following procedure.



ANL/DIS/TM-62 ELIST v.8.1: User’s Manual

March 2002 5-47

3. Click the Browse button. The EnablerMatch Export File window
opens (Figure 5.45).

 Figure 5.45  EnablerMatch Export File Window

Note: To import a file, first locate an export file. Use the
EnablerMatch Export File window to do so.

4.  Perform one of the following:

•  To select a filename, highlight it and then click OK. The
EnablerMatch Export File window closes, and the filename is
automatically displayed in the Import EnablerMatch Export
File window.

•  To cancel this operation, click Cancel. The EnablerMatch
Export File window closes.

5. Perform one of the following on the Import EnablerMatch Export
File window.

•  To import the ELIST format file, click OK. The file is
imported, and the Import EnablerMatch Export File window
closes.

•  To cancel this operation, click Cancel. The Import
EnablerMatch Export File window closes.



ANL/DIS/TM-62 ELIST v.8.1: User’s Manual

March 2002 5-48

5.3.5.6  To Export an ELIST Format File

The Import (ELIST Format) command allows you to import an enabler
match file in the ELIST 8 format.

To Export an Enabler Match File

1. As needed, display the enabler attributes (see Procedure 5.3.5.1).

2. On the File menu, click Export (ELIST Format). The Export File
window opens (Figure 5.46).

Figure 5.46  Export File Window

3. Type the path and name of the file in the File Name text box.

4. Perform one of the following:

•  To export the file, click OK. If the filename is acceptable, the
file is saved in the C:\ELIST\ELIST8_data directory, and the
Export File window closes.

Note: If a filename was not entered in the Export File
window or if an incorrect filename was entered in Step 3,
a warning is displayed, advising you that a filename was
not entered.

•  To cancel this operation, click Cancel. The Export File
window closes.
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5.4  Folder Commands

Two Folder commands are available on the ELIST window:  New and
Delete. Windows are described in detail in Chapter 6. Table 5.8 gives
brief descriptions of the Folder commands. Procedures for using these
commands are provided on the following pages.

Table 5.8  Folder Commands

Command Description

New Creates a folder in which all data required for developing a scenario
and then running a simulation is contained.

Delete Removes a folder and all the data it contains from the database.
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5.4.1  Folder>New Command

To Create a Folder

1. On the Folder menu, click New. The New Folder window opens
(Figure 5.47).

Figure 5.47  New Folder Window

2. Type a name for the new folder in the text box.

Note:  If you enter a folder name that exists in the database,
an error message is displayed.

3. Perform one of the following steps:

•  To create this folder, click OK. The New Folder window
closes.

•  To cancel this operation, click Cancel. The New Folder
window closes.
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5.4.2  Folder>Delete Command

To Delete a Folder

1. On the Folder menu, click Delete. The Delete Folder window
opens (Figure 5.48).

Figure 5.48  Delete Folder Window

Note:  To create a report of the folders, click Print. The
Report window opens and displays a list of folder IDs and
names. The Report window is enabled only after the Delete
Folder window is closed.

2. Scroll the list, as needed, and click the name of the folder to be
deleted. The selected folder name is highlighted.
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3. Click OK. The Delete Warning windows opens (Figures 5.49).

Figure 5.49  Delete Warning Window

4. Perform one of the following:

•  To delete the selected folder, click Continue. The folder is
deleted, and the Delete Warning window closes.

•  To cancel this operation, click Cancel. The Delete Warning
window closes.
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5.5 Rules Commands

Seven Rules commands are available on the ELIST window: New,
Load, Edit, Unload, Delete, Import (ELIST Format), and Export (ELIST
Format). Windows are described in detail in Chapter 6. Table 5.9 gives
brief descriptions of the Rules commands. Procedures for using these
commands are provided on the following pages.

Table 5.9  Rules Commands

Command Description

New Creates a set of rules (see Section 5.5.1).

Load Loads a set of rules (loads it into memory) (see Section 5.5.2).

Edit Makes changes to a loaded set of rules (see Section 5.5.3).

Unload Unloads a set of rules (see Section 5.5.4).

Delete Removes a set of rules (see Section 5.5.5).

Imprt            (ELIST
Format)

Imports an ELIST 7 commodity set (see Section 5.5.6).

Export
(ELIST Format)

Imports a set of rules to an ELIST 7 format (see Section 5.5.7).
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5.5.1  Rules>New Command

To Create a Rule (Rule Set)

1. On the Rules menu, click New. The New Rules window opens
(Figure 5.50).

Figure 5.50  New Rules Window

Note:  To sort the items in a column and list them in
ascending/descending alphanumeric/date order, click the title
of the column. When a column title is clicked, an arrow is
displayed in the corresponding column title indicating the
direction of the sort.

2. Click the Folder �����������	
���������������
���������������

3. Click the name of the folder that is to contain the new rule set. The
drop-down list closes, and the selected name is displayed in the
Folder text box.

4. In the Rule Set Name text box, type a name for the new rule set.

5. Perform one of the following:

•  To create the rule, click OK. The SET CURRENT? window
opens (Figure 5.51). Skip to Step 6.

Figure 5.51  SET CURRENT? Window
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•  To copy the selected rule set and save it with a new name, in
the Rules to copy (optional) table, click the name of a
commodity (rule set). The commodity name is highlighted.
Skip to Step 7.

6. On the SET CURRENT? window, perform one of the following:

•  To set the current rule set as the current set, click OK. The SET
CURRENT? window closes.

•  To cancel this operation, click No. The SET CURRENT?
window closes and no rule is created.

7. On the New Rules window, perform one of the following:

•  To copy the selected rule set and save it with a new name, click
OK. The New Rules window closes. To edit this new rule set,
see Section 5.5.3.

•  To cancel this operation, click Cancel. The New Rules window
closes.
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5.5.2  Rules>Load Command

To load a Rule (Rule Set)

1. On the Rules menu, click Load. The Load Rules window opens
(Figure 5.52).

Figure 5.52  Load Rules Window

Note:  To sort the items in a column and list them in
ascending/descending alphanumeric/date order, click the title
of the column. When a column title is clicked, an arrow is
displayed in the corresponding column title indicating the
direction of the sort.

2. Click the Folder �����������	
���������������
�������
�

3. Click the name of the folder that contains the rule set that you want
to use. The drop-down list closes, and the selected folder name is
displayed in the Folder text box. The names of the rule sets
contained in the selected folder are also displayed in the Rule Sets
panel.

4. In the Name column, click the name of the rule set that is to be
opened.

5. Perform one of the following steps:

•  To load the selected rule set, click OK. The selected rule set is
loaded into memory, and the Load Rules window closes. If the
selected rule set is already in memory, a dialog box opens that
asks you to confirm this operation.

•  To select a different rule set, return to Step 3.

•  To cancel this operation, click Cancel. The Load Rules
window closes.
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5.5.3 Rules>Edit Command

The following Rules data can be edited:  Commodities, Commodity
Rules, Mode/Source Rules, Asset Definition, and Carry Preferences.

Note 1: Use ETEdit to edit rules data. Two versions of ETEdit
are available: the version incorporated into ELIST and the
stand-alone version. The menus and commands of these two
versions differ. The procedures described in this manual refer
to the version of ETEdit that has been incorporated into
ELIST. The stand-alone version of ETEdit is documented in a
separate manual.

Note 2: Many of the windows also contain the  (Show
Update Log) and  (Show Status) icons. The Show Update
Log tracks the changes made in a window and allows you to
selectively undo changes. The  (Show Status) icon allows
you to display errors and warnings associated with the data.
(See Section 5.1.)

Note 3: The Edit command is disabled until a rule set or
scenario is loaded.
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5.5.3.1 Edit—Commodities Tab

To Edit Commodities

Commodities are placed into user-defined categories of cargo so that
users have control over how commodities are moved during the
simulation. (See Section 5.5.3.5, Edit—Carry Preferences Tab.)

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed (Figure 5.53).

Figure 5.53  ETEdit: Rules Window

Note:  To sort the items in a column and list them in
ascending/descending alphanumeric/date order, click the title
of the column. When a column title is clicked, an arrow is
displayed in the corresponding column title indicating the
direction of the sort.

3. As needed, click the Commodities tab. The contents of the
Commodities tab are displayed.

4. Skip to Step 6 to edit Offload Type. To edit any other attribute of a
commodity, click any cell in the table. The row is highlighted.
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5. Double-click any cell and edit the data as needed.

6. To change the Offload Type for a specific commodity, click the
corresponding cell in that column. A drop-down list opens,
displaying the following types:  Breakbulk, RORO, Container,
POL, and PAX.

7. Select the Offload Type for the commodity.

Note:  ETEdit automatically checks that the selected offload
type is correct for the commodity. If it is not correct, the
column changes color indicating that the information is not
correct.

8. Select the offload type needed for the commodity from the drop-
down list. The information in the adjacent columns changes
(highlighted in a different color) if you need to supply new data for
the offload type, and a check box is displayed to indicate
availability.

To Add a Commodity to the List

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed (Figure 5.54).

Figure 5.54  ETEdit: Rules Window
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Note:  To sort the items in a column and list them in
ascending/descending alphanumeric/date order, click the title
of the column. When a column title is clicked, an arrow is
displayed in the corresponding column title indicating the
direction of the sort.

3. As needed, click the Commodities tab. The contents of the
Commodities tab are displayed.

4. Click  at the bottom of the window. The Define Commodity
window opens (Figure 5.55). The commodity selected on the
ETEdit: Rules window (Commodities tab) determines the
information initially displayed in this window.

Figure 5.55  Define Commodity Window

5. Click the Name text box and type the commodity name.

6. Enter the remaining information in the window. The Category type
selected on this window determines the other information that is
displayed on this window.

Note:  ELIST does not accept duplicate names. A new
name must be selected for the commodity each time one is
add to the list.

7. Perform one of the following:

•  To add the new commodity to the database, click OK. The new
commodity is added to the bottom of the list if no commodity
has been highlighted and immediately below a commodity that
is highlighted. The Define Commodity window closes.

•  To cancel this operation, click Cancel. The Define Commodity
window closes.
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To Delete a Commodity from the List

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Commodities tab. The contents of the
Commodities tab are displayed (Figure 5.56).

Figure 5.56  ETEdit: Rules Window—Commodities Tab

Note:  To sort the items in a column and list them in
ascending/descending alphanumeric/date order, click the title
of the column. When a column title is clicked, an arrow is
displayed in the corresponding column title indicating the
direction of the sort.

4. Click the name of the commodity to be deleted. The selected line is
highlighted.

5. Click  at the bottom of the window. The Confirm delete window
opens (Figure 5.57).

Figure 5.57  Confirm delete Window
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6. Perform one of the following:

•  To delete the commodity, click Yes. The Confirm delete
window closes, and the selected commodity is deleted from the
list.

•  To cancel this operation, click No. The Confirm Delete window
closes and the commodity is not deleted.

Note 1: Changes can be displayed at any time by
clicking the  (Show Update Log) icon at the upper
right. The Change Log: ETEdit Rules window lists all
changes made to the scenario and gives you the
opportunity to cancel the changes (click Undo) or to
exit the window (click Done). For a description of these
windows, see Chapter 6.

Note 2: Commodity parameters that have been assigned
wrong values can be displayed at any time by clicking

the  (Show Status) icon at the upper right. The
ILLEGAL_MODEL window opens and displays these
parameters and the value that should be assigned to
each. For a description of this window, see Chapter 6.
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5.5.3.2 Edit—Commodity Rules Tab

Commodity rules allow you to define what cargo items are to be
assigned to specific commodities.

To Change the Position of a Commodity Rule

Note:  Rules should be entered, starting with the most general
and going to the most specific.

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Commodity Rules tab. The contents of the
Commodity Rules tab are displayed (Figure 5.58).

Figure 5.58  ETEdit: Rules Window—Commodity Rules Tab

Note:  To sort the items in a column and list them in
ascending/descending alphanumeric/date order, click the title
of the column. When a column title is clicked, an arrow is
displayed in the corresponding column title indicating the
direction of the sort.



ANL/DIS/TM-62 ELIST v.8.1:  User’s Manual

February 2002 5-64

4. Click the commodity rule that is to be moved. The selected line is
highlighted.

5. Perform one of the following:

•  To move the commodity rule higher (more general) on the list,
click ����������������������	�
��	��������������������
moves one position higher each time �����������

•  To move the commodity rule lower (more specific) on the list,
click ����������������������	�
��	��������������������
moves one position lower each time �����������

To Add a Commodity Rule to the List

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Commodity Rules tab. The contents of the
Commodity Rules tab are displayed (Figure 5.59).

Figure 5.59  ETEdit: Rules Window—Commodity Rules Tab
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Note:  To sort the items in a column and list them in
ascending/descending alphanumeric/date order, click the title
of the column. When a column title is clicked, an arrow is
displayed in the corresponding column title indicating the
direction of the sort.

4. On the list of commodity rules, click the line where the new
commodity rule is to be located. The selected line is highlighted.

5. Click  at the bottom of the window. The Compose Rule window
opens (Figure 5.60).

Figure 5.60  Compose Rule Window

6. Click the Rule Name text box and type a name for the new rule.
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7. Click the Set… button next to the Premise text box. The Set
Premise window opens (Figure 5.61).

Figure 5.61  Set Premise Window

8. In the Keys panel, click the name of a requirement line number
(RLN) attribute. The selected RLN attribute is highlighted, and the
text and list boxes in the right panel display values for the selected
attribute (Figure 5.62).

Figure 5.62  Set Premise Window

9. As needed, click the Arguments �����������	
�������
“arguments” is displayed. Otherwise, skip to Step 11.

10. Click the desired argument. The drop-down list closes and the
selected argument is displayed in the Arguments text/list box.
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11. As needed, click the Operator �����������	
������������������
is displayed. The default operator is “=.” Otherwise, skip to
Step 13.

12. Click the desired operator. The drop-down list closes, and the
selected operator is displayed in the Operator text box.

13. As needed, click the Comparison Type �����������	
�������
“comparison types” is displayed. Otherwise, skip to Step 15.

14. Click the desired comparison type. The drop-down list closes, and
the selected comparison type is displayed in the Comparison Type
text box.

15. Perform one of the following:

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Values, select the required
value(s). These values are highlighted when selected. Skip to
Step 20.

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Integer Value, Text Value, or
Real Value, type the value in the text box. When the
Comparison Type text box is labeled Text Value, click the
Ignore Case check box, as needed. Skip to Step 20.

•  When the Comparison Type text box contains Field and the
text box below it is labeled Field, click the Set… button. The
Select Field window opens (Figure 5.63).

Figure 5.63  Select Field Window

16. On the Select Field window, in the Keys panel, select the required
key. The selected key is highlighted, and the Key Description text
box is filled in.

17. If needed, click the Arguments �����������	
��������������
�
opens. Otherwise, skip to Step 19.
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18. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Arguments text box.

19. Perform one of the following:

•  To save the information entered on the Select Field window,
click OK. The Select Field window closes.

•  To cancel this operation without saving the information entered
on the Select Field window, click Cancel. The Select Field
window closes.

20. On the Set Premise window, click the Negate Result check box,
as required.

21. To create a multi-predicate premise, click the Advanced Mode
check box at the top of the window. The Set Premise window
expands at the bottom. Otherwise, skip to Step 24.

22. Perform the following, as needed, on the expanded Set Premise
window.

•  To change the Logical Operator, click the ��������������������
this text box.

•  To change the Mode between Add and Modify, click the
corresponding radio button.

23. The procedure for lower panel will be documented in a future
version of this manual.

24. Perform one of the following:

•  To save the changes made to the RLN attributes, click OK. The
Set Premise window closes, and the string representing your
selection is displayed on the Compose Rule in the Premise text
box.

•  To cancel this operation without saving any changes, click
Cancel. The Set Premise window closes.

25. As needed, on the Compose Rule window, click the
Arguments �����������	
���������������
��������������
Otherwise, skip to Step 27.

26. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Argument text box.
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27. As needed, click the Comparison Type �����������	
�������
“comparison types” is displayed. Otherwise, skip to Step 29.

28. Click the desired comparison type. The drop-down list closes, and
the selected comparison type is displayed in the Comparison Type
text box.

29. Perform one of the following:

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Value, skip to Step 30.

•  When the Comparison Type text box contains Field and the
text box below it is labeled Field, skip to Step 31.

30. When the Comparison Type text box contains User Value and the
text box below it is labeled Values, select the required value(s).
The selected value(s) is highlighted when selected, Skip to Step x.

31. When the Comparison Type text box contains Field and the text
box below it is labeled Field, click the Set… button. The Select
Field window opens (Figure 5.64).

Figure 5.64  Select Field Window

32. In the Keys panel, select the required key. The selected key is
highlighted, and the Key Description text box is filled in.

33. If needed, click the Arguments �����������	
��������������
�
opens. Otherwise, skip to Step 37.

34. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Arguments text box.

35.  Perform one of the following:

•  To save the information entered on the Select Field window,
click OK. The Select Field window closes.
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•  To cancel this operation without saving the information entered
on the Select Field window, click Cancel. The Select Field
window closes.

36. As required, check the Negate Results check box.

37. Perform one of the following:

•  To save the new rule set, click OK. The Compose Rule
window closes, and the new rule is added to the list of rules.

•  To cancel this operation without saving the new rule, click
Cancel. The Compose Rule window closes.

38. To add another rule to this list, repeat Steps 4 through 37.

39. As needed, change the position of the new commodity rule on the
list (see previous topic).

To Delete a Commodity Rule from the List

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. On the Rules menu, click Edit. The ETEdit:  Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Commodity Rules tab. The contents of the
Commodity Rules tab are displayed (Figure 5.65).

Figure 5.65  ETEdit: Rules Window—Commodity Rules Tab
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4. Click the name of the commodity rule to be deleted. The selected
line is highlighted.

5. Click the  at the bottom of the window. The Confirm delete
window opens (Figure 5.66).

Figure 5.66  Confirm delete Window

6.  Perform one of the following:

•  To delete the selected rule, click Yes. The Confirm delete
window closes, and the selected rule is deleted from the list.

•  To cancel this operation without deleting the commodity rule,
click No. The Confirm delete window closes, and the rule is not
deleted from the list.

To Edit Commodity Rules

1. As needed, load the rule (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. On the Rule menu, click Edit. The ETEdit:  Rules window opens,
and the contents of a tab are displayed.
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3. As needed, click the Commodity Rules tab. The contents of the
Commodity Rules tab are displayed (Figure 5.67).

Figure 5.67  ETEdit: Rules Window—Commodity Rules Tab

4. Click the name of the commodity rule to be edited. The selected
line is highlighted.
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5. Click  (edit button) at the bottom of the window. The Compose
Rule window opens (Figure 5.68).

Figure 5.68  Compose Rule Window

6. In the Resultants list box, select the required resultant. The
selected resultant is highlighted, and the Resultant Description text
box is filled in.

7. To change the rule name, click the Rule Name text box and enter a
new name. Otherwise, skip to Step 8.
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8. To change the Premise, click the Set… button. The Set Premise
window opens (Figure 5.69). Otherwise, skip to Step 25.

Figure 5.69  Set Premise Window

9. In the Keys panel at the left, click the name of the commodity to be
edited. The selected commodity is highlighted, and the boxes at the
right display information about the corresponding commodity
(Figure 5.70).

Figure 5.70  Set Premise Window
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10. As needed, click the Arguments �����������	
�������
“arguments” is displayed (Figure 5.71). Otherwise, skip to Step 12.

Figure 5.71  Set Premise Window

11. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Arguments text box.

12. As needed, click the Operator �����������	
������������������
is displayed. Otherwise, skip to Step 14.

13. Click the desired operator. The drop-down list closes, and the
selected operator is displayed in the Operator text box.

14. As needed, click the Comparison Type �����������	
�������
“comparison types” is displayed. Otherwise, skip to Step 16.

15. Click the desired comparison type. The drop-down list closes, and
the selected comparison type is displayed in the Comparison Type
text box.

16. Perform one of the following:

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Values, skip to Step 17.

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Integer Value, Text Value, or
Real Value, skip to Step 18.

•  When the Comparison Type text box contains Field and the
text box below it is labeled Field, skip to Step 19.
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17. When the Comparison Type text box contains User Value and the
text box below it is labeled Values, select the required value(s).
The selected values are highlighted when selected. Skip to Step 24.

18. When the Comparison Type text box contains User Value and the
text box below it is labeled Integer Value, Text Value, or Real
Value, type the value in the corresponding text box. Skip to
Step 24.

19. When the Comparison Type text box contains Field and the text
box below it is labeld Field, click the Set… button. The Select
Field window opens (Figure 5.72).

Figure 5.72  Select Field Window

20. In the Keys panel, click a key name. The selected key is
highlighted, and the Key Description text box is filled in.

21. If needed, click the Arguments �����������	
��������������
�
opens. Otherwise, skip to Step 23.

22. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Arguments text box.

23. Perform one of the following:

•  To save the information entered on the Select Field window,
click OK. The Select Field window closes.

•  To cancel this operation without saving the information entered
on the Select Field window, click Cancel. The Select Field
window closes.

24. As required, click the Negate Result check box.

25. Perform one of the following:

•  To save the changes made to the commodity premise, click OK.
The Set Premise window closes.
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•  To cancel this operation without saving any changes, click
Cancel. The Set Premise window closes.

26. To edit another commodity premise, repeat Steps 8 through 25.

Note:  The Advanced Mode option — available through a
check box at the top of the Set Premise window
(Figure 5.73) — has been not implemented at this time.

Figure 5.73  Set Premise Window--Advanced Mode

27. As needed, on the Compose Rule window, click the
Arguments �����������	
���������������
��������������
Otherwise, skip to Step 29.

28. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Argument text box.

29. As needed, click the Comparison Type �����������	
�������
“comparison types” is displayed. Otherwise, skip to Step 31.
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30. Click the desired comparison type. The drop-down list closes, and
the selected comparison type is displayed in the Comparison Type
text box.

31. Perform one of the following:

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Values, skip to Step 32.

•  When the Comparison Type text box contains Field and the
text box below it is labeled Field, skip to Step 33.

32. When the Comparison Type text box contains User Value and the
text box below it is labeled Values, select the required value(s).
The selected value(s) is highlighted when selected. Skip to Step x.

33. When the Comparison Type text box contains Field and the text
box below it is labeled Field, click the Set… button. The Select
Field window opens (Figure 5.74).

Figure 5.74  Select Field Window

34. In the Keys panel, select the required key. The selected key is
highlighted, and the Key Description text box is filled in.

35. If needed, click the Arguments �����������	
��������������
�
opens. Otherwise, skip to Step 37.

36. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Arguments text box.

37.  Perform one of the following:

•  To save the information entered on the Select Field window,
click OK. The Select Field window closes.

•  To cancel this operation without saving the information entered
on the Select Field window, click Cancel. The Select Field
window closes.
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38. As required, check the Negate Results check box.

39. Perform one of the following:

•  To save the changes made to the rule, click OK. The Compose
Rule window closes.

•  To cancel this operation without saving any changes, click
Cancel. The Compose Rule window closes.

40.  To edit another commodity rule, repeat Steps 3 through 39.

5.5.3.3 Edit ���������	�
����
���

To Change the Position of a Mode/Source Rule

Note:  Rules should be entered, starting with the most general
and going to the most specific.

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Mode/Source Rules tab. The contents of the
Mode/Source Rules tab are displayed (Figure 5.75).

Figure 5.75  ETEdit: Rules Window—Mode/Source Rules Tab
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4. Click the mode/source rule that is to be moved. The selected rule is
highlighted.

5. Perform one of the following:

•  To move the mode/source rule higher (more general) on the
list, click ����������������������	�
��	����������������
rule moves one position higher each time �����������

•  To move the mode/source rule lower (more specific) on the
list, click ����������������������	�
��	����������������
rule moves one position lower each time �����������

To Add a Mode/Source Rule to the List

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. As needed, on the Rules menu, click Edit. The ETEdit: Rules
window opens, and the contents of a tab are displayed.

3. As needed, click the Mode/Source Rules tab. The contents of the
Mode/Source Rules tab are displayed (Figure 5.76).

Figure 5.76  ETEdit: Rules—Mode/Source Rules Tab

4. On the list of mode/source rules, click the line where the new
mode/source rule is to be located. The selected line is highlighted.



ANL/DIS/TM-62 ELIST v.8.1:  User’s Manual

February 2002 5-81

5. Click  at the bottom of the window. The Compose Rule window
opens (Figure 5.77).

Figure 5.77  Compose Rule Window

6. Click the Rule Name text box type a name for the new rule.

7. Click the Set… button next to the Set Premise text box. The Set
Premise window opens (Figure 5.78).

Figure 5.78  Set Premise Window
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8. In the Keys panel at the left, click the name of a requirement line
number (RLN) attribute. The selected RLN attribute is highlighted,
and the text and list boxes at the right display values for the
selected attribute (Figure 5.79).

Figure 5.79  Set Premise Window

9. As needed, click the Arguments �����������	
�������
“arguments” is displayed. Otherwise, skip to Step 11.

10. Click the desired argument. The drop-down list closes and the
selected argument is displayed in the Arguments text/list box.

11. As needed, click the Operator �����������	
������������������
is displayed. The default operator is “=.” Otherwise, skip to
Step 13.

12. Click the desired operator. The drop-down list closes, and the
selected operator is displayed in the Operator text box.

13. As needed, click the Comparison Type �����������	
�������
“comparison types” is displayed. Otherwise, skip to Step 15.

14. Click the desired comparison type. The drop-down list closes, and
the selected comparison type is displayed in the Comparison Type
text box.
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15. Perform one of the following:

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Values, select the required
value(s). These values are highlighted when selected. Skip to
Step 20.

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Integer Value, Text Value, or
Real Value, type the value in the text box. When the
Comparison Type text box is labeled Text Value, click the
Ignore Case check box, as needed. Skip to Step 20.

•  When the Comparison Type text box contains Field and the
text box below it is labeled Field, click the Set… button. The
Select Field window opens (Figure 5.80).

Figure 5.80  Select Field Window

16. On the Select Field window, in the Keys panel, select the required
key. The selected key is highlighted, and the Key Description text
box is filled in.

17. If needed, click the Arguments �����������	
��������������
�
opens. Otherwise, skip to Step 19.

18. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Arguments text box.

19. Perform one of the following:

•  To save the information entered on the Select Field window,
click OK. The Select Field window closes.

•  To cancel this operation without saving the information entered
on the Select Field window, click Cancel. The Select Field
window closes.

20. On the Set Premise window, click the Negate Result check box,
as required.
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21. To create a multi-predicate premise, click the Advanced Mode
check box at the top of the window. The Set Premise window
expands at the bottom. Otherwise, skip to Step 24.

22. Perform the following, as needed, on the expanded Set Premise
window.

•  To change the Logical Operator, click the ��������������������
this text box.

•  To change the Mode between Add and Modify, click the
corresponding radio button.

23. The procedure for lower panel will be documented in a future
version of this manual.

24. Perform one of the following:

•  To save the changes made to the RLN attributes, click OK. The
Set Premise window closes, and the string representing your
selection is displayed on the Compose Rule in the Premise text
box.

•  To cancel this operation without saving any changes, click
Cancel. The Set Premise window closes.

25. As needed, on the Compose Rule window, click the
Arguments �����������	
���������������
��������������
Otherwise, skip to Step 27.

26. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Argument text box.

27. As needed, click the Comparison Type �����������	
�������
“comparison types” is displayed. Otherwise, skip to Step 29.

28. Click the desired comparison type. The drop-down list closes, and
the selected comparison type is displayed in the Comparison Type
text box.

29. Perform one of the following:

•  When the Comparison Type text box contains User Value and
the text box below it is labeled Value, skip to Step 30.

•  When the Comparison Type text box contains Field and the
text box below it is labeled Field, skip to Step 31.
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30. When the Comparison Type text box contains User Value and the
text box below it is labeled Values, select the required value(s).
The selected value(s) is highlighted when selected, Skip to Step x.

31. When the Comparison Type text box contains Field and the text
box below it is labeled Field, click the Set… button. The Select
Field window opens (Figure 5.81).

Figure 5.81  Select Field Window

32. In the Keys panel, select the required key. The selected key is
highlighted, and the Key Description text box is filled in.

33. If needed, click the Arguments �����������	
��������������
�
opens. Otherwise, skip to Step 37.

34. Click the desired argument. The drop-down list closes, and the
selected argument is displayed in the Arguments text box.

35.  Perform one of the following:

•  To save the information entered on the Select Field window,
click OK. The Select Field window closes.

•  To cancel this operation without saving the information entered
on the Select Field window, click Cancel. The Select Field
window closes.

36. As required, check the Negate Results check box.

37. Perform one of the following:

•  To save the new rule set, click OK. The Compose Rule
window closes, and the new rule is added to the list of rules.

•  To cancel this operation without saving the new rule, click
Cancel. The Compose Rule window closes.

38. To add another rule to this list, repeat Steps 4 through 37.
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39. As needed, change the position of the new mode/source rule on the
list.

To Delete a Mode/Source Rule

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. As needed, on the Rules menu, click Edit. The ETEdit: Rules
window opens, and the contents of a tab are displayed.

3. As needed, click the Mode/Source Rules tab. The contents of the
Mode/Source Rules tab are displayed.

4. Click the name of the mode/source rule to be deleted. The selected
line in highlighted.

5. Click  at the bottom of the window. The Confirm delete window
opens (Figure 5.82).

Figure 5.82  Confirm delete Window

6. Perform one of the following:

•  To delete the selected rule, click Yes. The Confirm delete
window closes, and the selected rule is deleted from the list.

•  To cancel this operation without deleting the mode/source rule,
click No. The Confirm delete window closes, and the rule is not
deleted from the list.

To Edit a Mode/Source Rule

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens, and the contents of a tab are displayed. Skip to
Step 3.

2. As needed, on the Rules menu, click Edit. The ETEdit: Rules
window opens, and the contents of a tab are displayed.
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3. As needed, click the Mode/Source Rules tab. The contents of the
Mode/Source Rules tab are displayed.

This procedure will be completed in a future version of this manual.
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5.5.3.4 Edit ���
����������
���

In the Asset Definitions tab, you group assets. Because assets are
grouped, you do not need to enter so many items when you work in the
Carry Preference tab. For example, you can place vehicles into groups, or
asset types, and then assign commodity carry preferences by groups rather
than by individual vehicles. This process saves time now and also later
when working with simulations.

To Add an Asset Definition to the List

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. As needed, on the Rules menu, click Edit. The ETEdit: Rules
window opens, and the contents of a tab are displayed.

3. As needed, click the Asset Definition tab. The contents of the Asset
Definition tab are displayed (Figure 5.83), and the three buttons at
the bottom of the window are disabled if no assets have been
selected for this rule. Otherwise, a hierarchy tree is displayed,
which shows the types of assets with individual vehicle types
displayed at the second level of the tree.

Figure 5.83  ETEdit: Rules Window—Asset Definition Tab

4. Click the asset definition folder below where the new asset is to be
placed. The three buttons at the bottom of the window are enabled.
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5. Click  at the bottom of the window. The Add Asset window
opens (Figure 5.84).

Figure 5.84  Add Asset Window

6. Type the name of the new asset in the Name text box.

7. As needed, click the Mode �����������	
����������������
displayed. Otherwise, skip to Step 9. Note:  mode refers to the
mode of transportation (e.g., rail).

8. Click the desired mode. The drop-down list closes, and the selected
mode is displayed in the Mode text box.

9. As needed, perform one of the following:

•  To allow the simulation to track the new asset, click the Yes
radio button.

•  To defer from tracking the new asset in the simulation, click
the No radio button.

10. As needed, perform one of the following:

•  To define this asset as a tractor line haul vehicle, click the
Tractor radio button.

•  To define this asset as a trailer line haul vehicle, click the
Trailer radio button.

11. From the list in the panel at the right, click the individual asset to
be assigned to this asset definition. The assets are highlighted
when selected.

12. Perform one of the following:

•  To save the information entered on the Add Asset window,
click OK. The Add Asset window closes, and the new asset
definition is added to the list.
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•  To cancel this operation without saving the information entered
on the Add Asset window, click Cancel. The Add Asset
window closes.

13. To add another asset definition, repeat Steps 4 through 12.

To Delete Vehicle Types from an Asset Definition

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. As needed, on the Rules menu, click Edit. The ETEdit: Rules
window opens, and the contents of a tab are displayed.

3. As needed, click the Asset Definition tab. The contents of the Asset
Definition tab are displayed, and the three buttons at the bottom of
the window are disabled if no assets have been selected for this
rule. Otherwise, a hierarchy tree is displayed, which shows the
types of assets with individual assets within the type folders.

4. Double-click the asset definition to be deleted. The name of the
asset is highlighted, the folder opens, and a list of vehicle types is
displayed. Confirm that this folder contains the asset to be deleted.

5. Click  (edit button) at the bottom of the window. The Edit Asset
window opens.

6. In the list box at the right, double-click the vehicle type to be
deleted. The selected vehicle type is no longer highlighted.

7. Perform one of the following:

•  To delete the selected vehicle type, click OK. The Add Asset
window closes, and the asset is deleted from the list.

•  To cancel this operation without deleting the vehicle type, click
Cancel. The Add Asset window closes.

8. To delete another vehicle type, repeat Steps 4 through 7.

To Delete an Asset Type (Folder)

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.
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2. As needed, on the Rule menu, click Edit. The ETEdit: Rules
window opens, and the contents of a tab are displayed.

3. As needed, click the Asset Definition tab. The contents of the Asset
Definitions tab are displayed, and the three buttons at the bottom of
the window are disabled if no assets have been defined for this
rule. Otherwise, a hierarchy tree is displayed that shows the types
of assets with individual assets within the type folders.

4. Click the asset definition folder to be deleted. The name of the
folder is highlighted.

5. Click  at the bottom of the window. One of the following
happens:

•  If the selected asset definition folder was added to the original
list, the folder and its contents are deleted from the list.

•  If the selected asset definition folder is an original folder, the
Confirm Delete window opens. Perform one of the following:

- To delete the selected asset definition folder, click Yes. The
Confirm Delete window closes, and the asset definition
folder is deleted from the list along with any corresponding
carry preference rules for the asset(s).

- To cancel this operation without deleting the asset
definition folder, click No. The Confirm Delete window
closes.

6. To delete another asset definition folder, repeat Steps 4 and 5.

To Edit an Asset Definition

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. As needed, on the Rules menu, click Edit. The ETEdit: Rules
window opens and the contents of a tab are displayed.

3. As needed, click the Asset Definition tab. The contents of the Asset
Definition tab are displayed.

4. Click the name of the asset definition folder that is to be edited.
The selected line name is highlighted.
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5. Click  (edit button) at the bottom of the window. The Edit Asset
window opens for the selected asset (Figure 5.85).

Figure 5.85  Edit Asset Window

6. As needed, change the information on this window.

7. Perform one of the following:

•  To save the information entered on the Edit Asset window,
click OK. The Edit Asset window closes.

•  To cancel this operation without saving the information entered
on the Edit Asset window, click Cancel. The Edit Asset
window closes.

8. To edit another asset definition, repeat Steps 4 through 7.

5.5.3.5 Edit �����
��������	�
���

To Add an Asset Type or Mode to a Commodity Preference List

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.
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3. As needed, click the Carry Preferences tab. The contents of the
Carry Preference tab are displayed (Figure 5.86).

Figure 5.86  ETEdit: Rules Window—Carry Preference Tab

4. Click the name of the commodity to which another asset or mode
is to be added. The selected commodity is highlighted, and the
asset(s) or mode(s) designated to carry the selected commodity are
displayed at the right side of the window.

5. Click  at the bottom of the window. The Choose one window
opens (Figure 5.87).

Figure 5.87  Choose one Window

6. Select an asset type or mode from the list. The selected asset type
or mode is highlighted.

7. Perform one of the following:

•  To designate the selected asset type or mode as available to
carry the particular commodity, click OK. The Choose One
window closes, and the selected asset type or mode is added to
the bottom of the Carried by list.
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•  To cancel this operation, click Cancel. The Choose One
window closes.

8. To add another asset type or mode to a commodity, repeat Steps 4
through 7.

To Delete an Asset Type or Mode from a Commodity

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Carry Preferences tab. The current
commodities table and the carry preference rule table are
displayed.

4. Click the name of the commodity from which you want to delete
an asset type or mode. The selected commodity is highlighted, and
the asset type(s) and mode(s) designated to carry the selected
commodity are displayed at the right side of the window.

5. At the right side of the window, click the name of the asset type or
mode to be deleted. The selected item is highlighted.

6. Click  at the bottom of the window. The selected item is deleted
from the list.

7. To delete another asset type or mode from a commodity, repeat
Steps 6 through 7.

To Change the Position (Priority) of an Asset Type or Mode

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Carry Preferences tab. The current
commodities table and the carry preference rule table are
displayed.

4. Click the name of the commodity that contains the asset type or
mode that is to be moved in the list. The selected commodity is
highlighted, and the asset type(s) and mode(s) designated to carry
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the selected commodity are displayed at the right side of the
window.

5. At the right side of the window, click the name of the asset type or
mode to be moved. The selected item is highlighted.

6. Perform the following as needed:

•  To move the selected asset type or mode up one place, click �

•  To move the selected asset type or mode down one place,
click �

7. To change the position of another asset type or mode, repeat
Steps 4 through 6.

To Edit an Asset Type or Mode

1. As needed, load a rule set (see Section 5.5.2). The ETEdit: Rules
window opens. Skip to Step 3.

2. On the Rules menu, click Edit. The ETEdit: Rules window opens,
and the contents of a tab are displayed.

3. As needed, click the Carry Preferences tab. The current
commodities table and the carry preference rule table are
displayed.

4. Click the name of the commodity that contains the asset type or
mode that is to be edited. The selected line is highlighted, and the
asset type(s) and mode(s) designated to carry the selected
commodity are displayed at the right side of the window.

5. At the right side of the window, click the name of the asset type or
mode to be edited. The selected item is highlighted.

6. If needed, click the Time Restriction text box. A drop-down list of
time parameters is displayed. Otherwise, skip to Step 8.

7. Click the desired time parameter. The drop-down list closes, and
the selected parameter is displayed in the Time Restriction text
box.

8. As needed, click the Distance Restriction text box. A drop-down
list of “operators” is displayed. Otherwise, skip to Step 11.

9. Click the desired operator. The drop-down list closes, and the
selected operator is displayed in the Distance Restriction text box.
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10. Click the Miles text box and enter the appropriate number of miles
for the selected operator to complete the distance restriction rule.

11. To edit another asset type or mode, repeat Steps 4 through 10.
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5.5.4 Rules>Unload Command

The Unload command allows you to remove the current rule set from
computer memory (RAM).

To Unload a Rule Set

1. On the Rules menu, click Unload. The Unload RuleSet Warning
window opens (Figure 5.88).

Figure 5.88  Unload RuleSet Warning Window

2.  Perform one of the following:

•  To unload the current rule set, click Continue. The Unload
RuleSet Warning window closes, and the rule set is unloaded
from memory.

•  To cancel this operation, click Cancel. The Unload RuleSet
Warning window closes, and the rule set is not unloaded from
memory.
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5.5.5 Rules>Delete Command

The Delete command allows you to delete the following from a folder:
a rule set, which consists of commodities; assets; carry preference rules;
and commodity and mode/source rules.

To Delete a Rule Set

1. On the Rules menu, click Delete. The Delete Rules window opens
(Figure 5.89).

Figure 5.89  Delete Rules Window

2. Click the Folder �����������	
���������������
�������
�

3. Select the folder that contains the commodity set to be deleted. The
drop-down list closes, and the name of that folder is displayed in
the Folder text box.

4. In the Commodities panel, click the commodity to be deleted. The
selected rule is highlighted.

5. Click OK and then perform one of the following:

•  If the rule is associated with one or more ETPFDDs, a warning
window (Figure 5.90) opens that displays information about
deleting the rule set. Click OK to keep from deleting the rule
set.

Figure 5.90  Warning Window
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•  If the commodity is not associated with an ETPFDD, a Confirm
Delete window (Figure 5.91) opens. Click Yes to delete the file
or click No to return to the Delete Commodities window.

Figure 5.91  Confirm Delete Window

Note: To undo a change made to a rule, perform one of
the following:

������������  (Show Update Log) icon to view a list of
changes. Select Undo to cancel the change (the
deleted commodity is returned to the bottom of the
list).

���
�����ETEdit: Commodities window, click
File>Cancel Changes. You must confirm that you
want to cancel the changes. You can then begin again.
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5.5.6 Rules>Import (ELIST Format) Command

The Import (ELIST Format) command allows you to import a rule set
from a file that has previously been exported from ELIST 8.

To Import a Rule Set

1. On the Rules menu, click Import (ELIST Format). The Import
Rules Export File window opens (Figure 5.92).

Figure 5.92  Import Rules Export File Window

Note:  If you know the path and name of the file to be
imported, type it in the Rule Set Export File text box and
click OK. Otherwise, follow the steps listed below.

2. Click the Browse button. The Rule Set Export File window opens
(Figure 5.93).

Figure 5.93 Rule Set Export File Window
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3. Perform one of the following:

•  To import a file, click the filename. The selected filename is
highlighted. Then click OK. The Rule Set Export File window
closes, and the file is imported.

•  To cancel this operation, click Cancel. The Rule Set Export
File window closes.

4. As needed, click the Folder �����������	
���������������
�����
displayed. Otherwise, skip to Step 6.

5. Click the desired folder name. The drop-down list closes, and the
name of that folder is displayed in the Folder text box.

6. Perform one of the following:

•  To continue this operation, click OK. The …                   and
the Import Rules Export File window closes.

•  To cancel this operation, click Cancel. The Import Rules
Export File window closes.

Note:  A new window opens when you import/export a file so that
you can see what is happening.
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5.5.7 Rules>Export (ELIST Format) Command

The Export (ELIST Format) command allows you to import a set of
rules (a commodity set) in the ELIST 8 format.

To Export a Rule Set

1. On the Rules menu, click Export (ELIST Format). The ELIST
window opens (Figure 5.94).

Figure 5.94  ELIST Window

2. Click the Folder �����������	
���������������
���������������

3. Click the name of the folder in which the rule set is saved. The
drop-down list of folder names closes, and the selected name is
displayed in the Folder text box.

4. On the Rule Sets panel, click the name of the rule set to be
exported. The selected line is highlighted.

5. Perform one of the following:

To export the rule set, perform the following:

i. On the ELIST window, click OK. The Export Rules
window opens (Figure 5.95).

Figure 5.95  Export Rules Window

ii. Type a name for the exported rule set in the File Name text
box.
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iii. To export the rule set, click OK. The Export Rules window
closes and the rule set is saved in the
C:\ELIST\ELIST8_data directory. After a moment, the
Export Log window opens. Close the Export Log window.

To cancel this operation, click Cancel. The Export Rules
window closes.
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5.6  ETPFDD Commands

Twelve ETPFDD commands are available on the ELIST window: New,
Load, Edit, Unload, Delete, Import ETPFDD, Export ETPFDD, Import B8
File, Export B8 File, Import JFAST/B8 Projection, Import JFAST
Projection, and Import MIDAS Log File. Windows are described in detail in
Chapter 6. Table 5.10 gives brief descriptions of the ETPFDD commands.
Procedures for using these commands are provided on the following
pages.

Table 5.10  ETPFDD Commands

Command Description

New Create an ETPFDD or open/load an ETPFDD, edit it, and save it as a
new ETPFDD (see Section 5.6.1).

Load Load an ETPFDD from the database into memory for the purpose of
editing the ETPFDD (see Section 5.6.2). Editing an ETPFDD is
accomplished through the ETEdit (main) window, which loads when
the ETPFDD>Load command is used.

Edit This command is not enabled.

Unload Unload an ETPFDD from the computer’s memory (RAM) (see
Section 5.6.4).

Delete Remove an ETPFDD from the database (see Section 5.6.5).

Import
ETPFDD

Import an ETPFDD file from an outside source (see Section 5.6.6).

Export
ETPFDD

Export an ETPFDD file (see Section 5.6.7).

Import
B8 File

Import movement requirements to a standard B8 format TPFDD file
(see Section 5.6.8).

Export
B8 File

Export movement requirements from a standard B8 format TPFDD
file (see Section 5.6.9).

Import JFAST
B8/ Projection

Import a TPFDD from a B8 file and create a new projection based on
results from the JFAST model (see Section 5.6.10).

Import JFAST
Projection

Load the results of a JFAST model run onto the current ETPFDD in
ELIST (see Section 5.6.11).

Import MIDAS
Log File

Import a MIDAS log file and create a projection on the currently
loaded ETPFDD (see Section 5.6.12).
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5.6.1 ETPFFD>New Command

The New command will be documented in a future version of this
manual.
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5.6.2 ETPFDD>Load Command

The Load command allows you to load an ETPFDD from the database
into memory. An ETPFDD contains a set of requirement line numbers
(RLNs), groupings of RLNs (force modules), detailed records about
RLNs, and a parent hierarchy of RLNs. An ETPFDD must be loaded
before it can be edited.

To Load an ETPFDD (Using ELIST)

1. On the ETFPDD menu, click Load. The Load ETPFDD window
opens (Figure 5.96).

Figure 5.96  Load ETPFDD Window

2. Click the Folder �����������	
���������������
���������������

3. Click the desired folder name. The drop-down list closes, and the
selected folder name is displayed in the Folder text box. The names
of the ETPFDDs contained in the selected folder are also displayed
in the ETPFDDs panel.

4. In the ETPFDDs panel, click the name of the ETPFDD to be
loaded. The selected ETPFDD name is highlighted, and the
Projections text box automatically displays the name of an
associated projection, if there is one. If the Projections text box is
filled in, skip to Step 7.

5. If a projection is not displayed in Step 4, click the Projections �
A drop-down list of projection names for the selected ETPFDD is
displayed.

6. Click the name of the projection that you want to use for this
ETPFDD. The drop-down list closes, and the selected projection
name is displayed in the Projections text box.
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7. Perform one of the following:

•  To load the selected ETPFDD, click OK. After a short time, the
Load ETPFDD window closes, and the ETEdit (main) window
opens (Figure 5.97).

Figure 5.97  ETEdit (Main) Window

•  To select a different ETPFDD, return to Step 2.

•  To cancel this operation, click Cancel. The Load ETPFDD
window closes.
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5.6.3 ETPFDD>Edit Command

Refer to the ETEdit Manual for these procedures.

5.6.4 ETPFDD>Unload Command

After an ETPFDD has been loaded, clicking ETPFDD>Unload
removes the loaded ETPFDD from memory (RAM).
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5.6.5 ETPFDD>Delete Command

To Delete an ETPFDD (Using ELIST)

1. On the ETPFDD menu, click Delete. The Delete ETPFDD window
opens (Figure 5.98).

Figure 5.98  Delete ETPFDD Window

2. Click the Folder �����������	
���������������
���������������

3. Select the desired name from the drop-down list. The drop-down
list closes, and the selected folder name is displayed in the Folder
text box.

4. From the list displayed in the ETPFDDs panel, click the name of
the ETPFDD to be deleted. The name of the selected ETPFDD is
highlighted.

5. Click OK. The Confirm Delete window opens.

6. Perform one of the following:

•  To delete the selected ETPFDD, click Yes. The Confirm Delete
window closes, and the selected ETPFDD is removed from the
list in the Delete ETPFDD window.

•  To cancel this operation, click Cancel. The Delete ETPFDD
window closes.

7. Repeat Steps 4 through 6 to delete additional ETPFDDs.

8. When finished deleting ETPFDDs, on the Delete ETPFDD
window, click Cancel. The Delete ETPFDD window closes.
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5.6.6 ETPFDD>Import ETPFDD Command

Note:  Importing an ETPFDD also imports the rule set associated
with it.

To Import an ETPFDD (Using ELIST)

1. On the ETPFDD menu, click Import ETPFDD. The Import
ETPFDD Export File window opens (Figure 5.99).

Figure 5.99  Import ETPFDD Export File Window

2. Perform one of the following:

•  Type the path and filename in the ETPFDD Export File text
box.
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•  Click Browse and select the filename from the list on the
ETPFDD Export File window (Figure 5.100).

Figure 5.100  ETPFDD Export File Window

3. Click the Folder �����������	
���������������
���������������

4. Select the destination folder from the drop-down list. The drop-
down list closes, and the selected folder name is displayed in the
Folder text box.

5. In the TUCHA Sets panel, select a TUCHA set from the list to
associate with this ETPFDD. The name of the selected TUCHA set
is highlighted.

6. In the GEOLOC Sets panel, select a GEOLOC set to associate
with this ETPFDD. The name of the selected GEOLOC set is
highlighted.

7. Perform one of the following:

•  To import this ETPFDD, click OK. The Import ETPFDD Export
File window closes. If the requested ETPFDD does not exist, a
window opens telling you that fact and prompting you to
reenter the name.

•  To cancel this operation, click Cancel. The Import ETPFDD
Export File window closes.
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5.6.7 ETPFDD>Export ETPFDD Command

Note:  Exporting an ETPFDD also exports the rule set associated
with it.

To Export an ETPFDD (Using ELIST)

1. On the ETPFDD menu, click Export ETPFDD. The Export
ETPFDD window opens (Figure 5.101).

Figure 5.101  Export ETPFDD Window

2. Click the Folder �����������	
���������������
���������������

3. Select the desired folder from the drop-down list. The drop-down
list closes, and the selected folder name is displayed in the Folder
text box.

4. From the list displayed in the ETPFDDs panel, click the name of
the ETPFDD to be exported. The name of the selected ETPFDD is
highlighted.

5. Click OK. The Input window opens (Figure 5.102).

Figure 5.102  Input Window

6. Type the name of the ETPFDD to be exported in the Export File
Name text box.



ANL/DIS/TM-62 ELIST v.8.1:  User’s Manual

February 2002 5-114

7. Perform one of the following steps:

•  To export this ETPFDD, click OK. The Input window closes.

•  To cancel this operation, click Cancel. The Input window
closes.

8. Repeat Steps 2 through 7, as needed, to export additional
ETPFDDs.

9. To exit the Export ETPFDD window, click Cancel. The Export
ETPFDD window closes.
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5.6.8 ETPFDD>Import B8 File Command

To Import a B8 File (Using ELIST)

1. On the ETPFDD menu, click Import B8 File. The Import B8 File
window opens (Figure 5.103).

Figure 5.103  Import B8 File Window

2. Perform one of the following:

•  In the B8 File text box, type the path and filename of the
B8 file to be imported.

•  Click Browse to select a filename from the drop-down list.

3. In the ETPFDD Name text box, type a filename for the new
ETPFDD.

4. Click the Folder �����������	
���������������
���������������

5. Select the destination folder from the drop-down list. The drop-
down list closes, and the selected folder name is displayed in the
Folder text box.
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6. In the Commodities, TUCHA Sets, and GEOLOC Sets panels,
select a commodity set, TUCHA set, and GEOLOC set
respectively, to be associated with this ETPFDD. Each selection is
highlighted when selected.

7. Perform one of the following:

•  To import this B8 file, click OK. The Import B8 File window
closes.

•  To cancel this operation, click Cancel. The Import B8 File
window closes.

8. Perform one of the following:

•  To import additional B8 files, repeat Steps 2 through 7, as
needed.

•  To exit the Import B8 File window, click Cancel. The Import
B8 File window closes.
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5.6.9 ETPFDD>Export B8 File Command

To Export a B8 File (Using ELIST)

1. On the ETPFDD menu, click Export B8 File. The Export B8
window opens (Figure 5.104).

Figure 5.104  Export B8 Window

2. Click the Folder �����������	
���������������
���������������

3. Select the folder that contains the ETPFDD file from the drop-
down list. The drop-down list closes, and the selected folder name
is displayed in the Folder text box.

4. In the ETPFDDs panel, select the desired ETPFDD from the list.
The selection is highlighted.

5. Perform one of the following:

•  To export the B8 file, click OK. The Input window opens
(Figure 5.105).

Figure 5.105  Input Window

•  To cancel this operation, click Cancel. The Export B8 window
closes.

6. In the B8 File Name text box, type the filename of the B8 export
file.

7. Click OK. The Input window closes, and the B8 file is saved in the
C:\ELIST\ELIST8_data directory.
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8. Perform one of the following:

•  To export additional B8 files, repeat Steps 2 through 7.

•  To exit the Export B8 window, click Cancel. The Export B8
window closes.
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5.6.10  ETPFDD>Import JFAST B8/Projection Command

To Import a JFAST B8/Projection

Use the following procedure to create a JFAST B8/projection by
selecting from ready-made files (i.e., JFAST TPFDDs, Rule Sets, TUCHA
Sets, and GEOLOC Sets).

1. On the ETPFDD menu, click Import JFAST B8/Projection. The
Import JFAST B8 File window opens (Figure 5.106).

Figure 5.106  Import JFAST B8 File Window

2. In the JFAST TPFDDs panel, click the desired TPFDD name. The
selected line is highlighted.

3. In the ETPFDD Name text box, type the name for the new
JFAST B8 file.

4. In the Folder list box, select the folder in which this JFAST B8 file
is to be stored.
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5. In the Rules Sets panel, click the rules name. The selected line is
highlighted.

6. In the TUCHA Sets panel, click the desired TUCHA set name. The
selected line is highlighted.

7. In the GEOLOC Sets panel, click the desired GEOLOC set ID.
The selected line is highlighted.

8. Perform one of the following:

•  To import this JFAST B8/projection, click OK. The Import
JFAST B8 File window closes and the new JFAST
B8/projection is added to the database.

•  To cancel this operation, click Cancel. The Import JFAST B8
File window closes.
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5.6.11  ETPFDD>Import JFAST Projection Command

To Import a JFAST Projection (Using ELIST)

1. As needed, open an ETPFDD (see previous procedure). The
ETEdit (main) window opens.

2. On the ETEdit (main) window, click File>Close. The ETEdit
(main) window closes.

3. On the ETPFDD menu, click Import JFAST Projection. The Import
JFAST Projection window opens (Figure 5.107).

Figure 5.107  Import JFAST Projection Window

4. In the New Projection Name text box, type the name for the
ETPFDD that will be created as a result of importing a JFAST
projection file.

5. Click the Folder �����������	
���������������
���������������

6. Select the destination folder from the drop-down list. The drop-
down list closes, and the selected folder name is displayed in the
Folder text box.

7. In the ETPFDDs panel, select the desired ETPFDD from the list.
The selection is highlighted.
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8. Perform one of the following:

•  To import the JFAST projection, click OK. The Import JFAST
Projection window closes.

•  To cancel this operation, click Cancel. The Import JFAST
Projection window closes.

9. Perform one of the following:

•  To import additional JFAST projections, repeat Steps 1
through 7.

•  To exit the Import JFAST Projection window, click Cancel.
The Import JFAST Projection window closes.
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5.6.12  ETPFDD>Import MIDAS Log File Command

To Import a MIDAS Log File (Using ELIST)

1. As needed, load an ETPFDD (see previous procedure). The ETEdit
(main) window opens.

2. On the ETEdit (main) window, click Cancel. The ETEdit (main)
window closes.

3. On the ETPFDD menu, click Import MIDAS Log File. The Import
MIDAS Projection window opens (Figure 5.108).

Figure 5.108  Import MIDAS Projection Window

4. Perform one of the following:

•  In the MIDAS LOG File text box, type the path and filename of
the file to be imported.

•  Click Browse and select the filename from a list.

5. In the New Projection Name text box, type the name for the
ETPFDD that will be created as a result of importing a MIDAS
LOG file.

6. Click the Folder �����������	
���������������
���������������

7. Select the destination folder from the drop-down list. The drop-
down list closes, and the selected folder name is displayed in the
Folder text box.

8. In the ETPFDDs panel, select the desired ETPFDD from the list.
The selection is highlighted.

9. Perform one of the following:

•  To import the MIDAS log file, click OK. The Import MIDAS
Projection window closes.

•  To cancel this operation, click Cancel. The Import MIDAS
Projection window closes.
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10. Perform one of the following:

•  To import additional MIDAS log files, repeat Steps 2
through 7.

•  To exit the Import MIDAS Projection window, click Cancel.
The Import MIDAS Projection window closes.
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5.7  Network Commands

Nine Network commands are available on the ELIST window: New,
Load, Edit, Unload, Delete, Import (ELIST Format), Export (ELIST
Format), Import (Land File), and Import (Network File). Windows are
described in detail in Chapter 6. Table 5.11 gives brief descriptions of the
Network commands. Procedures for using these commands are provided
on the following pages.

Table 5.11  Network Commands

Command Description

New Creates a network (see Section 5.7.1).

Load Loads a network from the database into memory (see
Section 5.7.2).

Edit Makes changes to a transportation infrastructure network. (see
Section 5.7.3).

Unload Unloads a network from memory (see Section 5.7.4).

Delete Removes a network from the database (see Section 5.7.5).

Import
(ELIST Format)

Imports an ELIST transportation infrastructure network export file
generated by ELIST (see Section 5.7.6).

Export
(ELIST Format)

Exports an ELIST transportation infrastructure network in a
format that can be used by ELIST on another computer (see
Section 5.7.7).

Import (Land File) Imports an ELIST transportation infrastructure network from an
ELIST Version 7 land file (see Section 5.7.8).

Import
(Network Files)

Imports an ELIST transportation infrastructure network from a
comma-delimited ASCII file (see Section 5.7.9).
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5.7.1 Network>New Command

Before you can create the first scenario, you must create a network.
This network is saved in the folder that contains the rules and ETPFDDs
required for the scenario.

To Create a Network

1. On the Network menu, click New. The New Network window
opens (Figure 5.109).

Figure 5.109  New Network Window

2. As needed, click the Folder �����������	
���������������
�����
displayed. Otherwise, skip to Step 4.

3. Click the name of the folder that contains the network to be copied.
The drop-down list of folder names closes, and the selected name
is displayed in the Folder text box.

4. As needed, click the Classification �����������	
���������������
classifications (i.e., Unclassified, Confidential, Secret, and Top
Secret) is displayed. Otherwise, skip to Step 6.

5. Click the required classification. The drop-down list of security
classifications closes, and the selected classification is displayed in
the Classification text box.

6. Click the Network Name text box, and type a name for the new
network.
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7. Perform one of the following:

•  To save the new network, click OK. One of the following
happens:

- The New Network window closes.

- If you have already loaded a scenario, a NOTICE window
opens (Figure 5.110). Click Yes to continue. The NOTICE
window closes, and the New Network window closes,
leaving the ELIST window open.

Figure 5.110  NOTICE Window

•  To cancel this operation, click Cancel. The New Network
window closes.
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5.7.2 Network>Load Command

To Load a Network

1. On the Network menu, click Load. The Load Network window
opens (Figure 5.111).

Figure 5.111  Load Network Window

2. As needed, click the Folder �����������	
���������������
�����
displayed. Otherwise, skip to Step 4.

3. Click the name of the folder to be loaded. The drop-down list
closes, and the selected folder name is displayed in the Folder text
box.

4. In the Networks panel, click the name of the network to be loaded.
The selected network is highlighted.
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5. Perform one of the following:

•  To load the selected network, click OK. The Load Network
window closes, and the ELIST:  Network window opens with
the contents of a tab displayed (Figure 5.112).

Figure 5.112  ELIST: Network Window

•  To cancel this operation, click Cancel. The Load Network
window closes.
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5.7.3 Network>Edit Command

Note:  The Edit command is disabled until a network or a scenario
is loaded.

5.7.3.1  To Search the Network for an Instance Name or Class

1. As needed, load a network. (See previous procedure.)

2. As needed, click the Hierachy tab.

3. On the ELIST:  Network window, click  . The Find Object in
Tree window opens (Figure 5.113).

Figure 5.113  Find Object in Tree Window

4. Click the Find Pattern text box, and type a search term.

5. To narrow the search, click the check box and appropriate radio
button. Otherwise, skip to Step 6.
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6. Click OK. If the search process finds the term, the Find Object in
Tree window closes, the hierarchy expands, and the search term is
highlighted (Figure 5.114).

Figure 5.114  ELIST: Network Window

5.7.3.2  To Add an Object to a Network Parent Class

1. As needed, load a network. (See previous procedure.)

2. As needed, click the Hierachy tab.
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3. On the ELIST: Network window, click the network parent class
(i.e., node, link, link feature, and so forth) to which the new
network object is to be added. The selected parent class is
highlighted (Figure 5.115).

Figure 5.115  ELIST: Network Window

4. On the ELIST: Network window, click . The New Network
Object window opens (Figure 5.116). Depending on the class
selected in Step 3, this window may be slightly different. The
parent class selected in Step 3 is listed to the right of Parent in this
window.

Figure 5.116  New Network Object Window

5. Click the Name text box and type a name for the new network
object.

6. Click OK. The New Network Object window closes, and the new
network object is added to the parent class selected in Step 3.

7. Repeat Steps 3 through 6 to add another network object.
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5.7.3.3  To Delete an Object from the Network

1. As needed, load a network. (See previous procedure.)

2. As needed, click the Hierachy tab.

3. On the ELIST: Network window, double-click the network parent
class that contains the network object to be deleted. The selected
parent class expands (Figure 5.117).

Figure 5.117  ELIST: Network Window

4. As needed, click  next to the class tree item (  ) that contains
the network object to be deleted. The selected class tree item
expands. Otherwise, proceed with Step 5.

5. Click the network object to be deleted. The selected object is
highlighted.

6. Click  at the top of the window. The Network Object Deletion
window opens (Figure 5.118).

Figure 5.118  Network Object Deletion Window
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7. Perform one of the following:

•  To delete the selected network object, click OK. The Network
Object Deletion window closes, and the object is deleted from
the network.

•  To cancel this operation, click Cancel. The Network Object
Deletion window closes.

8. To delete another network object, repeat Steps 3 through 7.

5.7.3.4  To Save a Network by Using the Save Command

Use the following procedure to save changes to a network.

1. In the ELIST: Network window, on the File menu, click Save. All
changes made to the network are saved to the database.

5.7.3.5  To Save a Network by Using the Save As Command

Use the following procedure to create a scenario by saving a scenario
with a different name.

1. In the ELIST: Network window, on the File menu, click Save As.
The Save Network As window opens (Figure 5.119).

Figure 5.119  Save Network As Window

2. Click the Folder �����������	
���������������
���������������

3. Click the name of the folder in which the new network is to be
saved. The drop-down list closes, and the selected folder name is
displayed in the Folder text box.

4. Click the Network Name text box, and type a name for the new
network.
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5. Perform one of the following:

•  To save this new network, click OK. The Save Network As
window closes, and the new network is saved to the database.

•  To cancel this operation, click Cancel. The Save As Network
window closes, and the new network name is displayed on the
ELIST:  Network window.

5.7.3.5  To Set the Network Source

This procedure will be documented in a future version of this manual.
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5.7.4 Network>Unload Command

To Unload a Network

1. On the Network menu, click Unload. The Unload Network Warning
window opens (Figure 5.120), which identifies the network to be
unloaded.

Figure 5.120  Unload Network Warning Window

3. Click Continue. The Unload Network Warning window closes, and
the network is unloaded.
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5.7.5 Network>Delete Command

To Delete a Network

1. On the Network menu, click Delete. The Delete Network window
opens (Figure 5.121).

Figure 5.121  Delete Network Window

2. Click the Folder �����������	
���������������
���������������

3. Select All Folders from the drop-down list. The drop-down list
closes, and All Folders is displayed in the Folder text box.

4. From the list displayed in the Networks panel, select a network.
The selected network is highlighted.

5. Click OK. The Confirm Delete window opens (Figure 5.122). The
name of the selected network is displayed (the example shows a
network named “Demo”).

Figure 5.122  Confirm Delete Window
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6. Perform one of the following:

•  To delete the selected network, click Yes. The Confirm Delete
window closes, and the selected network is removed from the
list of networks on the Delete Network window.

•  To cancel this operation, click No. The Confirm Delete window
closes.

7. Repeat Steps 4 through 6, as needed, to delete additional networks.

8. When you have finished deleting networks, click Cancel on the
Delete Network window. The Delete Network window closes.
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5.7.6 Network>Import (ELIST Format) Command

To Import an ELIST-Formatted Network

1. On the Network menu, click Import (ELIST Format). The Import
Network Export File window opens (Figure 5.123).

Figure 5.123  Import Network Export File Window

2. Perform one of the following:

•  Type the name, including the path, of the network to be
imported.

•  Click Browse and select a network from the window that
opens. The window shows a list of files to import.

3. Click the Folder �����������	
���������������
���������������

4. From the drop-down list, select the folder in which the imported
network is to be saved. The drop-down list closes, and the selected
folder name is displayed in the Folder text box.

5. Perform one of the following:

•  To import the selected network, click OK. The Import Network
Export File window closes.

•  To cancel this operation, click Cancel. The Import Network
Export File window closes.

6. Repeat Steps 2 through 5, as needed, to import additional
networks.
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5.7.7 Network>Export (ELIST Format) Command

To export an ELIST-formatted network

1. On the Network menu, click Export (ELIST Format). The Export
Network window opens (Figure 5.124).

Figure 5.124  Export Network Window

2. Click the Folder �����������	
���������������
���������������

3. Select the folder from the drop-down list. The drop-down list
closes, and the selected folder name is displayed in the Folder text
box.

4. In the Networks panel, select the network to be exported. The
selected network is highlighted.

5. Click OK. The Input window opens (Figure 5.125)

Figure 5.125  Input Window

6. Click the Export File Name text box, and type the name and path
for this network.

7. Perform one of the following:

•  To export the selected network, click OK. The Input window
closes, and the network is saved in the C:\ELIST\ELIST8_data
directory.
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Note:  When Cancel is clicked in the following step, a
window opens and displays the message stating no name
has been entered. Click OK.

•  To cancel this operation, click Cancel. The Input window
closes.

8. Repeat Steps 2 through 7, as needed, to export additional networks.

9. When you have finished exporting networks, click Cancel. The
Export Network window closes.
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5.7.8 Network>Import (Land File) Command

The Import (Land File) command allows you to import (insert into the
existing database) a network from a land file produced by ELIST 7.

To Import a Land File-Formatted Network

1. On the Network menu, click Import (Land File). The Import Land
File window opens (Figure 5.126).

Figure 5.126  Import Land File Window

2. Click the Folder �����������	
���������������
���������������

3. Select a folder name from the drop-down list. The drop-down list
closes, and the selected folder name is displayed in the Folder text
box.

4. In the Network Name text box, type a name for the new network,
including the source

5. Click the Classification �����������	
���������������
classifications is displayed.

6. Select a security classification from the drop-down list. The drop-
down list closes, and the selected classification is displayed in the
Classification text box.

7. Perform one of the following:

•  Type the directory and filename of the land file that is to be
imported.
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•  Click Browse and select a land file from the window that
opens. The window shows a list of files to import.

8. Perform one of the following:

•  Type the filename of an attribute match.

•  Click Browse and select a filename from the window that
opens. The window shows a list of files to import.

Note:  The filename matches the ELIST 7 attribute
names to ELIST 8 attribute names along with conversion
factors.

9. Perform one of the following:

•  Type the filename of a class match.

•  Click Browse and select a filename for a class match from the
window that opens. The window shows a list of files to import.

Note:  The filename matches the ELIST 7 class match
names to ELIST 8 attribute names along with conversion
factors.

10. Repeat Steps 2 through 9, as needed, to import additional
networks.
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5.7.9 Network>Import (Network Files) Command

This procedure will be documented in a future version of this manual.
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5.8 Scenario Commands

Eight Scenario commands are available on the ELIST window:  New,
Load, Edit, Unload, Delete, Import (ELIST Format), Export (ELIST
Format), Export (ELIST7 Format), and Import (ELIST.fpm). Windows are
described in detail in Chapter 6. Table 5.12 gives brief descriptions of the
Scenario commands. Procedures for using these commands are provided
on the following pages.

Table 5.12  Scenario Commands

Command Description

New Creates a scenario with an option of copying in to form an existing
scenario (see Section 5.8.1).

Load Loads a file and gives the option of beginning to run the scenario
immediately (see Section 5.8.2).

Edit Makes changes to scenarios, including theater, parameters, road/rail
data, crane rates, berths, asset pools, arriving assets, and MSEL (see
Section 5.8.3).

Unload Unload a scenario file from the memory (see Section 5.8.4).

Delete Removes a scenario file from the database (see Section 5.8.5).

Import
(ELIST Format)

Imports a scenario file from an outside source or from TUCHA and
GEOLOC sets (see Section 5.8.6).

Export
(ELIST Format)

Exports a scenario in a format that can be used by ELIST on another
computer (see Section 5.8.7).

Export
(ELIST7)

Exports a scenario in ELIST Ver. 7 format (.scen and arrive files) that
can be used by ELIST on another computer (see Section 5.8.8).

Import
(ELIST7.fpm)

Import the results of an ELIST Ver. 7 simulation (*.fpm file) (see
Section 5.8.9).
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5.8.1 Scenario>New Command

Note:  Before a scenario can be created, a folder must be created,
and the following items must be added to it:  a rule, a network, and
an ETPFDD. Refer to the corresponding procedures in this manual.

To Create a Scenario

1. On the Scenario menu, click New. The New Scenario window
opens (Figure 5.128).

Figure 5.128  New Scenario Window

2. Click the Folder �����������	
���������������
���������������

3. Click the destination folder name. The drop-down list of names
closes, and the selected name is displayed in the Folder text box.

4. Click the Scenario Name text box and type a name for the new
scenario.

Note:  If you enter a scenario name that has been used, a
warning window notifies you that a duplicate name exists.
Enter a different scenario name to continue.

5. Click the Network �����������	
��������
��	����
�����
displayed. The network describes the transportation infrastructure
to be used for simulating the movement of equipment or personnel.

6. Select the name of the network to be used for this scenario. The
drop-down list closes, and the selected name is displayed in the
Network text box.

7. Click the ETPFDD �����������	
���������������
�����
displayed.
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8. Select the name of an ETPFDD. The drop-down list closes, and the
selected name is displayed in the ETPFDD text box.

Note: To simulate a theater operation, you must select a
projection that provides loaded ships and planes arriving at
the theater.

9. Perform one of the following:

•  To select a projection, perform the following:

a. Click the Projection �����������	
�����������������

names is displayed.

b. Select the name of a projection. The drop-down list closes,
and the selected name is displayed in the ETPFDD text box.

c. Proceed to Step 10.

•  To create or add a new projection, perform the following:

a. Click the Add projection button. The ENTER A NAME
window opens.

b. Type a name for the new projection in the corresponding
text box. (The name is then added to the drop-down list of
projections.)

c. Click OK. The ENTER A NAME window closes, and the
new projection name is displayed in the Projection text box.

d. Proceed to Step 10.

10. As needed, in the Scenario to copy (optional) panel, click the name
of the scenario to be used. The selected scenario is highlighted.



ANL/DIS/TM-62            ELIST v.8.1:  User’s Manual

February 2002 5-148

11. Perform one of the following:

•  To create this scenario, click OK. The New Scenario window
closes.

Note:  If a rule set, ETPFDD, or network was opened
before this scenario was created, a warning window
opens stating, “Loading this Scenario will remove the
following data from memory.” Click Yes to continue.

•  To cancel this operation without saving the scenario, click
Cancel. The New Scenario window closes.
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5.8.2 Scenario>Load Command

To Load a Scenario

1. On the Scenario menu, click Load. The Load Scenario window
opens (Figure 5.129).

Figure 5.129  Load Scenario Window

2. Click the Folder �����������	
���������������
���������������

3. Select a folder name. The drop-down list of folder names closes,
and the selected folder name is displayed in the Folder text box.
The names of the scenarios contained in the selected folder are also
displayed in the Scenarios panel.

4. In the Scenario panel, click the scenario to be loaded. The selected
scenario name is highlighted.

5. Perform one of the following:

•  To load the selected scenario, click OK. The Load Scenario
window closes after a few minutes, depending on the scenario
and the configuration of your computer.

Note: If a rule set, ETPFDD, network, or another
scenario was loaded before reaching this step, a
warning window opens stating, “Loading this Scenario
will remove the following data from memory.” Click
Yes to continue.

•  To display/print the contents of the Scenarios panel, click
Print. The Report window opens with this information
displayed. To print this information, close the Load Scenario
window, and on the Report window, on the File menu, click
Print.
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•  To cancel this operation without loading a scenario, click
Cancel. The Load Scenario window closes.

•  To run a simulation using this scenario (without editing the
scenario), click Load and Run. The Load Scenario window
closes, and the Simulation Executing window opens
(Figure 5.130), which displays a progress bar. When the
progress bar reaches 100%, the Simulation Executing window
closes, and the ELIST: Simulation window opens
(Figure 5.131). Proceed to Section 5.9, Simulation Commands.

Figure 5.130  Simulation Executing Window

Figure 5.131  ELIST: Simulation Window
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5.8.3  Scenario>Edit Command

Note 1: The edit command is disabled until a scenario is loaded.

Note 2: If a simulation has been run, it must be reset
(Simulation>Reset command) before the loaded scenario can be
edited.

Use the following procedures to edit theater assignments, parameters,
road/rail, crane rates, berths, asset pools, arriving assets, and Master
Scenario of Events List (MSEL).

5.8.3.1  Scenario Window—Theater Tab

To Edit the Scenario Theater Assignments

1. As needed, load the scenario (see Section 5.8.2).

2. On the Scenario menu, click Edit. The ELIST: Scenario window
opens, and the content of the Theater tab is displayed
(Figure 5.132).

Figure 5.132  ELIST: Scenario Window—Theater Tab
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3. Select the state and country codes that comprise the theater from
either the States panel or the Countries and Regions panel. The
selected state and country are highlighted.

4. Perform one of the following:

•  To save the changes, on the File menu, click Save.

•  To save the changes in a new scenario or a scenario of a
different name, on the File menu, click Save As. The Save
Scenario As window opens. Type a scenario name and click
OK. The ELIST:  Scenario window remains open for additional
editing.

•  To cancel this operation without saving any changes, on the
File menu, click Cancel.

•  To close the ELIST:  Scenario window, on the File menu, click
Close.

5.8.3.2  Scenario Window—Parameters Tab

To Edit the Scenario Parameters

1. As needed, load the scenario (see Section 5.8.2).
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2. On the ELIST: Scenario window, click the Parameters tab. The
content of the Parameters tab is displayed (Figure 5.133).

Figure 5.133  ELIST: Scenario Window—Parameters Tab

General Panel

3. Type the Intervals/Day. Either type the days in the text box or
click �����������
���������
��
��������	�������
�������� ���
96 days.

4. Click the Travel Mode �����������	
���������������������
displayed.

5. Select the desired travel mode. The drop-down list closes, and the
travel mode is displayed in the Travel Mode text box.

6. In the Percent for Delivery/Marry/Assembly text box, type a
number.

7. In the Storage Utilization text box, type a number.

Note: Decimal and negative numbers can be entered in the
Storage Utilization text box, so careful entry of the
percentage is essential for development of a realistic
scenario.
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8. Check the applicable boxes to indicate the constraints required for
the scenario.

Note: Checking a check box limits the progress of the
scenario by restricting the resources. If left unchecked, the
simulation is not restricted by these parameters; rather, it
displays the projected use compared with the given
infrastructure capability.

Berth Parameters Panel

1. In the Time to Berth text box, type the number of hours required.

2. In the Time to Deberth text box, type the number of hours
required.

Maximum Wait Times for Adequate Load Panel

1. In the Maximum Fixed Wing Wait text box, type the number of
days required.

2. In the Maximum Rotary Wing Wait text box, type the number of
days required.

3. In the Maximum Watercraft Wait text box, type the number of days
required.

Note: The days can be integers or real numbers.

Aircraft and Watercraft Loads Panel

1. Type the percentages required for the attributes listed.

5.8.3.3  Scenario Window—Road/Rail Tab

To Edit the Scenario Road/Rail Attributes

1. As needed, load the scenario (see Section 5.8.2).
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2. On the ELIST: Scenario window, click the Road/Rail tab. The
content of the Road/Rail tab is displayed (Figure 5.134).

Figure 5.134  ELIST: Scenario Window—Road/Rail Tab

Serials Required For

1. Check the appropriate boxes to select the type of delivery: convoy,
line haul, military direct delivery, or commercial direct delivery.
Check as many boxes as required for the scenario.

Serials Travel

1. Type the variables for the attributes listed.

Default Road Route Limits

1. Type the minimum limits for the attributes listed.

Rail Travel

1. Type the percentage or the number of days, hours, or miles per
hour, respectively, for the attributes listed.

2. As needed, click the Train Travel Schedule �����������	
�������
train travel schedules is displayed. Otherwise, skip to Step 3.
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3. From the drop-down list of train travel schedules, select one of the
following: Continuous (nonstop), 12/12 (12 hours of travel/
12 hours of rail yard), 5/1/5/13, and 5/1. The drop-down list closes,
and the selection is displayed in the Train Travel Schedule text
box.

Road Travel

1. Type the percentage or number of days, hours, or miles per hour
for the Adequate Truck Load, Maximum Truck Weight, Line Haul
Transition Time, and Convoy Rate of March, respectively.

Note: At this time, there are no limitations as to the
number that can be specified for the scenario; entering a
realistic number will produce better results.

2. As needed, click the �����������	
������������!�������������
for the corresponding road travel type. Otherwise, skip to the topic
titled General Information.

3. From the drop-down list of schedules, select one of the following:
Continuous (nonstop) 12/12 (12 hours of travel/12 hours of rail
yard), 5/1/5/13, and 5/1.

5.8.3.4  Scenario Window—Crane Rates Tab

To Edit Scenario Crane Rates Attributes

1. As needed, load the scenario (see Section 5.8.2).
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2. On the ELIST: Scenario window, select the Crane Rates tab. The
content of the Crane Rates tab is displayed (Figure 5.135).

Figure 5.135  ELIST: Scenario Window—Crane Rates Tab

3. In each of the four panels, type the number of containers per day or
the number of short tons per day, as required for containers or
breakbulk.

5.8.3.5  Scenario Window—Berths Tab

To Edit the Scenario Berths Attributes

1. As needed, load the scenario.
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2. On the ELIST: Scenario window, select the Berths tab. The content
of the Berths tab is displayed (Figure 5.136).

Figure 5.136  ELIST: Scenario Window—Berths Tab

3. In the Ports and Berths panel, click the name of a port. The port
entry expands to show a list of berth names available at that port.

4. For each berth, or for a single, specific berth, assign the availability
by using the radio buttons at the right of the window. Check one of
the three choices. If you have selected Available or Not Available,
proceed to Step 5.

Note: The name of the selected berth is displayed at the
right of the window.

5. If you have selected Available for given span of days, type the
Start and End dates in the text boxes provided.

6. If needed, repeat Steps 3 through 5 to continue assigning
availability for all of the berths listed.



ANL/DIS/TM-62            ELIST v.8.1:  User’s Manual

February 2002 5-159

5.8.3.6  Scenario Window—Asset Pools Tab

To Edit the Scenario Asset Pools Attributes

Note: This tab allows you to assign nodes and vehicles to asset
pools and to view the changes on the ELIST map. This window
works interactively with the ELIST window.

1. As needed, load the scenario (see Section 5.8.2).

2. On the ELIST: Scenario window, click the Asset Pools tab. The
content of the Asset Pools tab is displayed (Figure 5.137).

Figure 5.137  ELIST: Scenario Window—Asset Pools Tab

3. In the Asset Pools panel, click the name of an asset pool in the list.
The selected asset pool is highlighted when selected. If nodes have
been assigned to the asset pool, they are listed in the Nodes Served
tab on this window. If nodes are not listed, they can be assigned
(see Step x).

Note: The name of the selected asset pool and the type are
displayed at the right in the Selected Asset Pool panel.
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4. To add or remove an asset pool, respectively click  or  in the
Asset Pools panel. The respective dialog windows opens after you
have clicked the button.

5. To pan to the home node of the selected pool, click .

6. To select a color for displaying the asset pool on the map, in the
Selected Asset Pool panel, click the Color �

7. To assign “home node” to the selected asset pool, click the button
at the right of Home Node. The identifying node number is
displayed.

•  To turn on map listening mode, click the Home Node button.

•  To turn off the map listening mode, click the Home Node
button.

Note:  The Home Node is identified on the map by the 
icon, or by a similar icon, depending on the type of node.

•  To select a region and choose from a node in the popup
window, select the node from the map.

8. Perform one of the following to define the nodes that can be served
from the selected asset pool. If no nodes are selected, all nodes in
the network can be assigned.

•  To add the node ID to the list in the Nodes Served panel, on
the ELIST window (the map), click a node.

•  To select the class (or category) needed for the scenario, on the
ELIST:  Scenario window, click the Class button and select the
class.

•  To narrow the search, on the ELIST: Scenario window, select
the Operation OR or AND operator to restrict the search.

•  To search by pattern, or strings of letters (i.e., “prt” for port,
“cty” for city, etc.), on the ELIST:  Scenario window, type the
search string in the Pattern text box.

Note:  For example, type a pattern such as “%cty” and
press Enter. The % symbol is required by Oracle.

•  Repeat Step 8 until the asset pool is completely defined for the
scenario.
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5.8.3.7  Scenario Window—Host Nation Assets Tab

To Add Host Nation Assets to the Scenario

The Add Host Nation Assets tab will be documented in a future version
of this manual.
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5.8.3.8  Scenario Window—Arriving Assets Tab

Use the following procedures to assign arriving assets to asset pools
for use by the scenario.

Note: ELIST scans each RLN in the TPFDD for UTC’s that are in
the Reference Asset Match panel. All RLN’s that match are
displayed. You can then assign how they will be used in the
simulation.

To Add Arriving Assets to the Scenario

1. As needed, load the scenario (see Section 5.8.2).

2. On the ELIST: Scenario window, select the Arriving Assets tab.
The content of the Arriving Assets is displayed (Figure 5.138).

Figure 5.138  ELIST: Scenario Window—Arriving Assets Tab
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3. In the ETPFDD RLNs with Arriving Assets panel, click the RLN
that contains the desired UTC default vehicle. The selected RLN is
highlighted, and the vehicle types are displayed in the Selected
UTC Default Vehicles panel.

Note:  ELIST scans each RLN in the TPFDD for UTC’s in
the reference Asset Match panel. All of the matching
UTC’s are displayed. You must then assign the way in
which they will be used by the simulation.

4. Click  . The Add Asset window opens (Figure 5.139).

Figure 5.139  Add Asset Window

5. Type required information in the text boxes as follows:

•  Select a vehicle type or combination (e.g., tractor/trailer).

•  Select the asset type needed for the vehicle type/combination.

•  Select an asset pool to which the vehicle type/combination is to
be assigned.

6. Check the required radio button to determine when the asset is to
be employed.

Note: If the Tactical radio button is checked, it implies that
the asset is not available for transporting theater supplies.

7. Click OK. The Add Asset window closes, and the vehicle
information is displayed in the Selected RLN Scenario Vehicles
panel.
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To Delete an RLN Vehicle from the Scenario

1. As needed, load the scenario (see Section 5.8.2).

2. On the ELIST: Scenario window, select the Arriving Assets tab.
The content of the Arriving Assets is displayed (Figure 5.140).

Figure 5.140  ELIST: Scenario Window—Arriving Assets Tab

3. In the ETPFDD RLNs with Arriving Assets panel, click the RLN
that contains the RLN scenario vehicle to be deleted. The selected
RLN is highlighted, and the UTC default vehicles and RLN
scenario vehicles are displayed in their corresponding panels.

4. Click the desired RLN scenario vehicle. The selected vehicle is
highlighted.

5. Click  . The selected vehicle is removed from the Selected RLN
Scenario Vehicles panel.
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5.8.3.9  Scenario Window—Arriving Enablers Tab

The Arriving Enablers tab will be documented in a future version of
this manual.
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5.8.3.9  Scenario Window—MSEL Tab

The MSEL tab will be documented in a future version of this manual.
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5.8.3.10  Scenario Window—Routes Tab

The Routes tab will be documented in a future version of this manual.
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5.8.4  Scenario>Unload Command

To Unload a Scenario

1. On the Scenario menu, click Unload. The Unload Scenario
Warning window opens (Figure 5.141), which identifies the
scenario to be unloaded.

Figure 5.141  Unload Scenario Warning Window

2. Click Continue. The Unload Scenario Warning window closes, and
the scenario is removed from memory.
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5.8.5  Scenario>Delete Command

To Delete a Scenario

1. On the Scenario menu, click Delete. The Delete Scenario window
opens (Figure 5.142).

Figure 5.142  Delete Scenario Window

2. Click the Folder �����������	
���������������
���������������

3. Select a folder. The drop-down list of folder names closes, and the
selected folder name is displayed in the Folder text box. The names
of the scenarios for the selected folder are displayed in the
Scenarios panel.

4. Click the name of the scenario to be deleted. The scenario name is
highlighted.

5. Perform one of the following on the Delete Scenario window:

•  To delete the selected scenario, click OK. The Delete Scenario
window closes.

•  To cancel this operation, click Cancel. The Delete Scenario
window closes.
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5.8.6  Scenario>Import (ELIST Format) Command

To Import a Scenario (ELIST Format)

Note: Importing a scenario also imports the rule set, ETPFDD,
and network associated with it.

1. On the Scenario menu, click Import (ELIST Format). The Import
Scenario Export File window opens (Figure 5.143).

Figure 5.143  Import Scenario Export File Window

2. Perform one of the following:

•  Type the path and scenario filename in the Scenario Export
File text box.
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•  Click Browse. The Scenario Export File window opens
(Figure 5.144). Select the scenario filename from the list. The
filename is highlighted when selected. Then click OK. The
Scenario Export File window closes.

Figure 5.144  Scenario Export File Window

3. Click the Folder �����������	
���������������
���������������

4. Select the destination folder into which the scenario is to be loaded
from the drop-down list. The drop-down list closes, and the
selected folder name is displayed in the Folder text box.

5. In the TUCHA Sets panel, select a TUCHA set from the list to
associate with this scenario, more specifically the TPFDD
associated with this scenario. The name of the selected TUCHA set
is highlighted.

6. In the GEOLOC Sets panel, select a GEOLOC set to associate
with this scenario, more specifically the TPFDD associated with
this scenario. The name of the selected GEOLOC set is
highlighted.

7. Perform one of the following:

•  To import this scenario, click OK. The Import Scenario Export
File window closes. If the requested scenario does not exist, a
window opens that prompts you to retype the name.

•  To cancel this operation, click Cancel. The Import Scenario
Export File window closes.
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8. Repeat Steps 1 through 7, as needed, to import additional
scenarios.
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5.8.7  Scenario>Export (ELIST Format) Command

To Export a Scenario (Using ELIST)

Note:  Exporting a scenario also exports the rule set,
ETPFDDs, and network associated with it.

1. On the Scenario menu, click Export (ELIST Format). The Export
Scenario window opens (Figure 5.145).

Figure 5.145  Export Scenario Window

2. Click the Folder �����������	
���������������
���������������

3. Select the desired folder from the drop-down list. The drop-down
list closes, and the selected folder name is displayed in the Folder
text box, as well as all scenarios in the folder.

4. From the list displayed in the Scenarios panel, click the name of
the scenario to be exported. The name of the selected scenario is
highlighted.

5. Click OK. The Input window opens (Figure 5.146).

Figure 5.146  Input Window

6. Type the filename of the scenario to be exported in the Export File
Name text box.

7. Perform one of the following steps:

•  To export this scenario, click OK. The Input window closes.

•  To cancel this operation, click Cancel. The Input window
closes.
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8. Repeat Steps 2 through 7, as needed, to export additional
scenarios.

9. To exit the Export Scenario window, click Cancel. The Export
Scenario window closes.
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5.8.8  Scenario>Export (ELIST7 Format) Command

The Scenario>Export (ELIST7 Format) command will be documented
in a future version of this manual.

5.8.9  Scenario>Import (ELIST7.fpm) Command

The Scenario>Import (ELIST7.fpm) command will be documented in a
future version of this manual.
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5.8.10  Scenario>Scenario Window “File” Commands

Four File commands are available on the Scenario window:  Save,
Save As, Cancel Changes, and Close. Windows are described in detail in
Chapter 6. Table 5.13 gives brief descriptions of the File commands.
Procedures for using these commands are provided on the following
pages.

Table 5.13  Scenario Window “File” Commands

Command Description

Save Save changes made to a scenario (see Section 5.8.10.1).

Save As Allows you to create a new scenario by saving the loaded scenario
using a different name (see Section 5.8.10.2).

Cancel
Changes

Cancel changes made to the scenario since it was last saved (see
Section 5.8.10.3).

Close Exit the window (see Section 5.8.10.4).

5.8.10.1 Save Command

Use the following procedure to save changes to a scenario.

1. In the ELIST: Scenario window, on the File menu, click Save. All
changes made to the network are saved to the file.

5.8.10.2  Save As Command

Use the following procedure to create a scenario by saving a scenario
with a different name.

1. As needed, load the desired scenario (see Section 5.8.2).
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2. On the File menu, click Save As. The Save Scenario As window
opens (Figure 5.147).

Figure 5.147  Save Scenario As Window

3. Type/modify the name for this scenario in the Scenario Name text
box.

4. Click the Network �����������	
��������
��	����
�����
displayed. The network describes the transportation infrastructure
to be used for simulating the movement of equipment or personnel.

5. Select the name of the network to be used for this scenario. The
drop-down list closes, and the selected name is displayed in the
Network text box.

6. Click the ETPFDD �����������	
���������������
�����
displayed.

7. Select the name of an ETPFDD. The drop-down list closes, and the
selected name is displayed in the ETPFDD text box.

Note:  To simulate a theater operation, you can select a
projection that provides loaded ships and planes arriving at
the theater.

8. Perform one of the following for projection:

•  To select a projection:

a. Click the Projection �����������	
�����������������

names is displayed.

b. Select the name of a projection. The drop-down list closes,
and the selected name is displayed in the ETPFDD text box.

c. Proceed to Step 9.
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•  To create or add a new projection:

a. Click the Add projection button. The ENTER A NAME
window opens.

b. Type a name for the new projection in the corresponding
text box. (The name is then added to the drop-down list of
projections.)

c. Click OK. The ENTER A NAME window closes, and the
new projection name is displayed in the Projection text box.

d. Proceed to Step 9.

9. Perform one of the following:

•  To save this scenario using a different name, click OK. The
Save Scenario As window closes.

•  To cancel this operation, click Cancel. The Save Scenario As
window closes.

5.8.10.3  Cancel Changes Command

Use the following procedure to cancel changes made to a scenario.

Note:  Only the changes made to the scenario since it was last
saved are canceled.

1. On the File menu, click Cancel Changes. The ELIST: Scenario
Window Exit window opens (Figure 5.148).

Figure 5.148  ELIST: Scenario Window Exit Window

2. Perform one of the following:

•  To save the changes made to the scenario since the last time it
was saved, click Yes. All changes made to the scenario are
saved, and the Scenario Window Exit window closes.
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•  To cancel the changes made to the scenario since the last time
it was saved, click No. All changes made to the scenario are
canceled, and the Scenario Window Exit window closes.

•  To cancel this operation, click Cancel. The Scenario Window
Exit window closes.

5.8.10.4 Close Command

Use the following procedure to close the ELIST: Scenario Window

1. On the File menu, click Close. One of the following occurs:

•  If the changes to the scenario have been saved and no other
changes have been made, the ELIST:  Scenario window closes.

•  If the changes to the scenario have not been saved, the ELIST:
Scenario Window Exit window opens (Figure 5.149). Proceed
to Step 2.

Figure 5.149  ELIST: Scenario Window Exit Window

2. Perform one of the following:

•  To save the changes made to the scenario since the last time it
was saved, click Yes. All changes made to the scenario are
saved, and the Scenario Window Exit and the ELIST:  Scenario
window closes.

•  To cancel the changes made to the scenario since the last time
it was saved, click No. All changes made to the scenario are
canceled, and the Scenario Window Exit and the ELIST:
Scenario windows close.

•  To cancel this operation, click Cancel. The Scenario Window
Exit and the ELIST:  Scenario window close.
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5.8.11  Scenario Window “Report” Commands

5.8.11.1 Scenario “Report” Commands

The Report command allows you to create seven different reports.

Note: This section describes the steps to follow for creating
“All” reports for a scenario. Except for minor differences in
commands, this procedure is the same for the following types of
reports:

•  Options.
•  Asset Pools.
•  Arriving Assets.
•  Arriving Enablers.
•  Commodity Movement Summary.
•  Routes.
•  Change Log.

1. As needed, load the scenario (see Section 5.8.2).
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2. On the ELIST: Scenario window, on the Report menu, click All.
The ELIST: Report window opens (Figure 5.150). (Refer to
Section 5.8.X for the ELIST: Report Window “File” Commands
procedures.

Figure 5.150  ELIST: Report Window

5.8.11.2 Change Log Command

See the Change Log description earlier in this chapter.
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5.9  Simulation Commands

After a scenario is loaded, three Simulation commands are available on
the ELIST window: Control Window, Reset, and Open HLA Federation.
The features available through the Simulation commands can be used to
run various simulations. Windows are described in detail in Chapter 6.
Table 5.14 gives brief descriptions of the Simulation commands.
Procedures for using these commands are provided on the following
pages.

Table 5.14  Simulation Commands

Command Description

Control Window Opens the simulation control window (see Section 5.9.1).

Reset Resets the simulation by returning all resources and asset sets to
their original state and all items to their starting locations (see
Section 5.9.2).

Open HLA
Federation

Begins a simulation inside an HLA federation, that is, link ELIST with
other models inside the federation (see Section 5.9.3).

5.9.1 Simulation>Control Window Command

There are two main purposes for the Simulation window: 1) to control
the simulation run, and 2) to display the results of the simulation. In
addition, this window can be used to tailor what is displayed by the reports
and graphs by specifying which RLNs are to be included by adding and
deleting RLN sets.

5.9.1.1  To Run a Simulation

1. As needed, load a scenario (see Section 5.8.2).

2. As needed, run projections (see Section 5.x.x).

3. As needed, on the Simulation menu, click Reset.
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4. On the Simulation menu, click Control Window. The ELIST:
Simulation window opens (Figure 5.151). The starting day of the
simulation is displayed at the right of Current Time.

Figure 5.151  ELIST: Simulation Window

5. Specify any special requirements through the six tabs, including
adding RLN or deleting RLN sets (see the following procedures).

6. Perform one of the following:

•  To run the simulation for a pre-defined time, click one of the
following buttons: Run 1 Hour, Run 1 Day, or Run 10 Days.
The Simulation Executing window (Figure 5.152) may or may
not be displayed while the simulation runs, depending on the
time it takes to run the simulation. This window closes when
the simulation has completed its run. The simulation run time
is also displayed at the right of Current Time on the Simulation
window.

Figure 5.152  Simulation Executing Window
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•  To run the simulation for a user-defined run time, click the Run
to text box and type the number of hours. Note: the number
entered must be greater than the start day displayed at the right
of Current Time. Then click the Run to button. The Simulation
Executing window (Figure 5.153) may or may not be displayed
while the simulation runs, depending on the time it takes to run
the simulation. This window closes when the simulation has
completed its run. The simulation run time is also displayed at
the right of Current Time on the Simulation window.

Figure 5.153  Simulation Executing Window

•  To run the simulation until all events have been removed from
the event stack, click the Run. The Simulation Executing
window (Figure 5.154) may or may not be displayed while the
simulation runs, depending on the time it takes to run the
simulation. This window closes when the simulation has
completed its run. The simulation run time is also displayed at
the right of Current Time on the Simulation window.

Figure 5.154  Simulation Executing Window

7. To display the results of the simulation, refer to Section 5.9.1.2.

5.9.1.2  To Display Reports and Graphs

1. As needed, run a simulation (see Section 5.9.1.1).

2. On the Simulation menu, click the tab that contains the
report/graph that is to be created.
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3. Click  (report) or   (graph) icon next to the type of report/graph
to be created. The ELIST: Report window opens (Figure 5.155) and
the corresponding report or graph is displayed.

Figure 5.155  ELIST: Sample Report Window

4. To display the simulation results for this item a different way,
right-click within the report/graph. A menu of report/graph options
(Figure 5.156) is displayed.

Figure 5.156  Report/Graph Options

6. Select an option. The menu closes and the report/graph changes to
reflect the choice.
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5.9.1.3  To Add an RLN Set to the Simulation   

Note:  The following procedure is for adding an RLN set to the
Delivery or Movements. Except for minor differences in the
information contained in the various windows, this same
procedure can also be used for adding an RLN Element Set or an
Event Set to the Delivery and Movements.

1. As needed, run a simulation (see Section 5.9.1.1).

2. As needed, click the Delivery or Movements tab. The contents of
the tab are displayed.

3. Click the far left  at the bottom of the window. The Select RLN’s
window opens (Figure 5.157).

Figure 5.157  Select RLN’s Window

4. Make the required selections on the Select RLN’s window. The OK
button is enabled when all the selections on this window are valid.

5. Click the OK button. The Enter Label for RLN Set window opens
(Figure 5.158).

Figure 5.158  Enter Label for RLN Set Window
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6.  Click the text box and type a name for the RLN set.

7. Click OK. The Enter Label for RLN Set window closes, and the
new RLN set is added to the Report on Set scroll box.

5.9.1.4  To Delete an RLN Set from the Simulation

Note:  The following procedure is for deleting an RLN set from
the Delivery or Movements. Except for minor differences in the
information contained in the various windows, this same
procedure can also be used for deleting an RLN Element Set or
an Event Set from the Delivery and Movements.

1. As needed, run a simulation (see Section 5.9.1.1).

2. As needed, click the Delivery or Movements tab. The contents of
the tab are displayed.

3. In the Report on Set scroll box, click the item that is to be deleted.
The selected item is highlighted, and information about the
selected item may be displayed in the Current Set Query panel.

5. Click . The selected item is deleted from the Report on Set
scroll box.

5.9.2 Simulation>Reset Command

The Reset command is used to initialize the software before running
another simulation. If the software is not reset before running another
simulation, erroneous results are displayed.

5.9.3 Simulation>Open HLA Federation Command

Refer to the AMP User’s Manual for information about this command.
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6  Window Descriptions

(This chapter is a placeholder for the window descriptions that will be
included in a later version of ELIST. The windows that will be described
are identified below.)

Compose Rule Window (2)

ELIST (Map) Window

ELIST:  Scenario Window

ELIST:  Simulation Window

Network>Edit:  ELIST Network Window

ETEdit (Lozenge) Window

New Network Object Window

Set Premise Window (2)
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7  Glossary

This chapter contains an integrated list of acronyms (including
units of measure) and a glossary of terms used in this user’s
manual.

ADRG:  ARC Digitized Raster Graphics.

Area of Operation:  A geographic region that includes all
contained nodes or a set of nodes.

Arriving Asset:  A piece or pieces of equipment in the theater
arrivals that can assist in moving other items.

Asset Type:  Cargo item or items that become scenario assets
upon arrival at the selected destination.

Asset Pool:  Vehicles assigned to the same group, as specified by
amount, asset type, vehicle type, and percent availability. Asset
pools have home nodes (see Home Node) and areas of operation
that corresponds to a set of additional service nodes that are
associated with the pool.

Berth:  A continuous straight side of a dock or wharf along which
one or more ships may be “berthed” while loading or unloading
cargo.

CADRG:  Compressed ARC Digitized Raster Graphics.

cbbl:  hundreds of barrels.

CG:  city graphics (various maps with scales ranging from
1:15,000 to 1:10,000).

COE:  Common Operating Environment.

Control:  Run a simulation, specifying the time. You can also print
reports from this window.

CONUS:  continental United States.

DBMS:  database management system.
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Dialog Box:  A status box that is displayed to inform you, for
example, that an error has occurred, that the program is processing
data, etc.

DII:  Defense Information Infrastructure.

DODX:

DTED:  Digital Terrain Elevation Data (number following
abbreviation indicates level; i.e., DTED1 + level 1 or 3 ARC
seconds sample rate [~100 m postings]).

EAD:  earliest arrival date.

ELIST:  Enhanced Logistics Intratheater Support Tool.

Enabler:  Something in the theater arrivals that can be used after
its arrival to increase the capability of the theater infrastructure.

ENCE:

ENPE:

EWC:
European railcars.

EWCE:

EWP:

EWPE:

FLOT:  forward line of troops.

Force Module:  collection of requirement line numbers used for
reporting.

FSS:  fast sea ship.

ft3:  cubic foot (feet).

gal:  gallon(s).

GB:  gigabyte(s) (1 billion bytes; either 1,000 or 1,024 megabytes,
where a megabyte is considered to be 220).

GEOCODE:  A nine-character identification code for a known
location.
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GEOLOC:  A GEO location file, i.e., a file of known locations that
the TPFDD can reference in GEOCODE.

GNC:  Global Navigation Chart (maps with scales of 1:5,000,000).

Ground Transportation Onload/Offload:  The capability to load
and unload road and rail transportation assets that contain cargo at
a node.

HEMTT:  heavy expanded mobility tactical truck.

HET:  heavy equipment transport (truck).

HEV:  heavy equipment vehicle.

Home Node: primary node of origin.

hr:  hour(s).

ILOC:  intermediate location.

in:  inch(es).

ISB:  intermediate staging base.

JNC:  Jet Navigation Chart (maps with scales of 1:2,000,000).

JOG:  Joint Operations Graphics (maps with scales of 1:250,000).

JOPES:  Joint Operation Planning and Execution System.

JRE:  Java runtime environment.

KNCE:

KRNBOX:

KRN:
Korean railcars.

KS:

KWC:

KWP:

LAD:  latest arrival date.
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Lash:  a type of ship.

Link:  a road, pipeline, rail, etc.

LMTV:  light medium tactical vehicle.

LRNP:  long-range narrow body pax plane.

LRWC:  long-range, wide-body cargo plane.

MB:  megabyte (1 million bytes).

MHL:

Model Selected:  An option to determine whether the model
should select the mode for a given movement. The simulation
should move the cargo via the mode specified in the TPPDD.
A model to choose or use what is specified in the TPFDD.

mph:  mile(s) per hour

MSEL:  Master Scenario of Events List.

MSR:  main supply route.

mt:  metric ton(s) or metric tonne(s)?.

MTV:  medium tactical vehicle?.

MV:

naut mi/hr:  nautical mile(s) per hour.

Network:  A representation of the infrastructure of a given area.

Node:  A city, airport, seaport, etc.

NSS:  not self-sustaining.

OCONUS:  outside the continental United States.

ONC:  Operational Navigation Chart (maps with scales of
1:1,000,000).
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Pan:  A display method in which a viewing “window” on the map
scans horizontally of vertically, like a camera, to bring off-screen
extensions of the current image smoothly into view.

Pax:  personnel.

PLS:  palletized loading system.

POL:  petroleum, oil, and lubricants.

RAM:  Random Access Memory.

RES:

RLN:  requirement line number.

RMMS:

RO/RO:  roll on, roll off.

Route:  A set of links that connect at an origin and a destination.

RRWP:

RS:

RSOI:  Reception Staging Onward Movement and Integration.

SAAM:  Special Assignment Airlift Mission.

Specified in Requirements:  A parameter within the Scenario
Edit window that specifies Travel Mode…….?.

Specified then Modeled: the mode is specified, but the model
does not choose the mode for the simulation; opposite of Model
Selected. Used together with Model Selected and Specified in
Requirements.

sq ft:  square foot (feet).

SQL:  structured query language, a database sublanguage used for
querying, updating, and managing relational databases.

SRNP:  short-range, narrow body pax plane.

SRWC:  short-range, wide-body cargo.
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SRWP:  short-range, narrow-body pax plane.

SS:  self-sustaining.

st:  short ton(s).

STAR Route:  A predetermined route performed each day for
sustainment for aircraft.

TACWAR:  Tactical Warfare Model

Thumbnail View:  A “picture-in-picture” window that shows the
entire map. A red rectangle highlights the area of the map that you
are currently viewing.

TLM:  topographic line map (maps with scales of 1:100,000 and
1:50,000).

TPC:  tactical pilotage chart (maps with scales of 1:500,000).

TPFDD:  Time Phase Force Deployment Data. A representation of
military movement requirements.

TTP:  trailer transfer point.

TUCHA:  Type Unit Characteristics File, or a data source that
consists of ASCII or database tables.

UHL:

UTC:

UTE:  utilization rate (i.e., capability of a fleet of aircraft to
generate flying hours in a day).

UWMAP:  urban vector map (map with vector data with various
source scales ranging from 1:15,000 to 1:10,000).

Vehicle Type:  A specific type of truck, tractor, trailer, railcar,
aircraft, ship, or helicopter that can be used to transport items, as
specified in a scenario.

VMAP:  vector map (the number following the VMAP
abbreviation indicates the level; i.e., VMAP1 = level 1 or vector
data with a scale of 1:250,000).
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VPF:  vector product format (all vector products are based on the
VPF standard MIL-STD-2407).

WVS:  World Vector Shoreline.

WVSPLUS:  World Vector Shoreline Plus (map of vector data
with various source scales).

Zoom:  A function that allows you to view a selected area more
closely, as an enlarged image.
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8  Documentation Improvement and Feedback

Comments and other feedback on this document should be directed to:

Phone: 630-252-5308
Fax: 630-252-6073
Email: vang@anl.gov
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